
Operating Instructions
With Installation Manual

(for qualified service personnel)

Electronic Board
(Interactive Panaboard)

Model No. UB-8325

Panaboard
• To assemble this unit, please refer to the Installation manual on page 83 through 99.
• Before operating this unit, please read these instructions completely and keep them carefully for future 

reference.
• Because of the nature of the print film, all the printed text will remain on the film.
• This unit is designed for installation by a qualified servicing dealer.

Installation performed by non-authorized individuals could cause safety-related problems with the operation of 
this equipment.

For U.S.A. only: 
• To locate the closest authorized dealer in your area, please call 1-800-449-8989.
Stand is optional.
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Thank you for purchasing the Panasonic Electronic Board.
For optimum performance and safety, please read these instructions carefully.

Q’ty
• Thermal transfer film   .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
• Markers (Black, Red, Blue-big)  .  .  .  .  .  . 1 each
• Eraser .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
• Pen holder .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2
• Markers for interactive

(Black, Red, Blue, Green-small)   .  .  .  .  . 1 each
• Electronic Eraser   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
• Eraser cloth (for Electronic Eraser)  .  .  .  .  .  .  . 2

Q’ty
• Batteries (LR03 “AAA”)   .  .  .  .  .  .  .  .  .  .  .  .  . 6
• Power cord   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
• USB cable [5 m (16’ 5 3/8”)]  .  .  .  .  .  .  .  .  .  .  . 1
• A4 (Letter*1) size copy paper  .  .  .  .  .  .  .  .  . 20
• Software CD-ROM   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
• Operating Instructions .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
• Wall-mounting template  .  .  .  .  .  .  .  .  .  .  .  .  . 1
• Warranty card*2  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1

*1 Letter size is for U.S.A. and Canada models.
*2 for U.S.A. model only.
* The markers (big) and the eraser are used for other than the interactive function.
* The markers for interactive (small) are used while inserted in the pen holder.

In this manual, the pen holder with a marker for interactive (small) is called the Electronic Pen.
The Electronic Pen and the Electronic Eraser are used with the interactive function.

* The stand and wall-mounting kit are optional. By way of example, this manual describes an Electronic Board which is 
used with the stand.

For your future reference

Date of purchase: _________________________ Serial number: ____________________________

Dealer’s name and address: ______________________________________________________________

Attach your sales receipt here

Things you should keep a record of

Accessories

Tel:
Warning about saving data
When the system storage device or any of its optional storage device is adversely effected by operational 
errors, static electricity, electrical noise, vibration, dust or when the power has been cut off due to malfunction, 
repair or inadvertently, the memory contents may be lost or changed. Before operating the system, make a 
point of reading the precautionary notes in the Operating Instructions and the help information, and observe 
them during operation.

Please observe carefully the following precaution:

•Make absolutely sure that all important data is saved by back-up or the original is saved.

The manufacturer hereby declares that it cannot be held accountable for any loss or change in any data 
stored on floppy disks, hard disks, optical disks, or other memory devices.



Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to 
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be required to correct the interference at 
his own expense.

• Microsoft, Windows, PowerPoint and CalliGrapher are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries.

• IBM is a trademark of International Business Machines Corporation in the United States, other countries, or both.
• Pentium is a trademark or registered trademark of Intel Corporation or its subsidiaries in the United States and 

other countries.
• Adobe, Acrobat, Acrobat Reader and Reader are either registered trademarks or trademarks of Adobe Systems 

Incorporated in the United States and/or other countries.
• SANFORD and EXPO are registered ® U.S. trademarks of SANFORD or its Affiliates.
• All trademarks referred to in this manual are property of their respective companies.

The information given in this Operating Instructions is subject to change without notice.

FCC Warning: To assure continued FCC compliance, the user must use only the provided power supply cord. 
Also, any unauthorized changes or modifications to this equipment would void the user’s authority 
to operate this device.

Federal Communications Commission Requirements
3
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The UB-8325 is equipped with two interactive functions; Projector mode and Whiteboard mode, in addition to a 
regular electronic board that utilizes plain paper. It is possible to use this unit as follows.

■ Electronic Board Functions

• Allows copying up to 9 copies per screen
• Allows printing in 2 level contrast (Normal / Dark)
• Allows printing of 2-screens at the time by compressing them into a single sheet of paper

■ Projector Mode (Interactive Function)

Connect the Interactive Panaboard to a computer that is connected to a projector and use the projector to project the 
image onto the Interactive Panaboard.
This is called the Projector mode.
In this mode, the following operations are possible:

• Operating the computer using the Electronic Pen with its cap on as a mouse
• Drawing handwritten lines or erasing it using the Electronic Pen or Electronic Eraser with its cap on in the projected 

image
• Saving the projected image to an image file and printing the projected image
• Recording the operations of drawing and erasing handwritten lines, playing back and editing the recorded 

operations later

In Projector mode, the projected computer image on the screen of the Interactive Panaboard can be operated by 
using the Electronic Pen as a mouse. You can execute the application and electronically write or erase notes. The 
electronically handwritten or partially erased computer image can be stored into an image file. This will help make 
your presentation more impressive to the attendants.

Features



■ Whiteboard Mode (Interactive Function)

By connecting the Interactive Panaboard to a computer, the information written on the Interactive Panaboard is 
displayed on the computer in real-time.
This is called the Whiteboard mode.
In this mode, the following operations are possible:
• The information written on the Interactive Panaboard using the Electronic Pen with its cap off will be displayed on 

the computer screen at the same time.
• The information erased using the Electronic Eraser will be erased in the computer as well.
• You can save drawings and notes into a file which can later be printed.
• Allows the user to record the information being written or erased in a file that can be played back as a movie and it 

can be edited if needed.

■ Computer Interfacing

Panasonic Document Management System (hereafter referred to as Panasonic-DMS) has the following functions. 
About the Panasonic-DMS, refer to the Document Management System operating instructions in the CD-ROM.

• Panasonic-DMS uses the TWAIN driver to scan monochrome images drawn on the UB-8325.
• Panasonic-DMS has a capability of managing documents (image files).
• The printer driver allows the printer of the UB-8325 to print documents from a computer.
5



6

For Your Safety. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
• For Users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
• For users in the United Kingdom only  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Precautions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
• CD-ROM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Part Names and Functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
• Control Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
• Electronic Pen and Eraser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Installing the Thermal Transfer Film. . . . . . . . . . . . . . . . . . . . . . . 18
Loading Copy Paper. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Making Copies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

• Copy Types and Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Replacing the Thermal Transfer Film . . . . . . . . . . . . . . . . . . . . . . 22
Paper Jams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Setting the Electronic Pen and Eraser . . . . . . . . . . . . . . . . . . . . . 25

• Setting the Electronic Pen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
• Setting the Electronic Eraser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
• Replacing the Eraser Cloth  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Installing Drivers and Software. . . . . . . . . . . . . . . . . . . . . . . . . . . 27
• System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
• Contents of CD-ROM. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
• Installing Drivers / Interactive Panaboard Software . . . . . . . . . . . . . . . . . . . . . 28
• Installing the Panasonic-DMS Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
• Removing Drivers / Interactive Panaboard Software . . . . . . . . . . . . . . . . . . . . 31
• Removing the Panasonic-DMS Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Using the Panaboard in Projector Mode  . . . . . . . . . . . . . . . . . . . 32
• Precautions When Using a Projector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
• Starting the Interactive Panaboard Software . . . . . . . . . . . . . . . . . . . . . . . . . . 33
• Pop-up Menu Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
• Basic Operation in Projector Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
• Using the Desktop Drawing Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Using the Panaboard in Whiteboard Mode  . . . . . . . . . . . . . . . . . 49
• Starting the Interactive Panaboard Software . . . . . . . . . . . . . . . . . . . . . . . . . . 49
• Pop-up Menu Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
• Basic Operation in Whiteboard Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

Using the View Window or Whiteboard Window. . . . . . . . . . . . . 53
• About View Window / Whiteboard Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
• Managing IPB Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Before You Start

Using

Page
Table of Contents



B
efore You Start

U
sing

H
elp

Installation
Using the Panasonic-DMS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
• Scanning  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
• Panaboard Operation Panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
• Printing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Daily Care and Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
• Cleaning the Screen and the Unit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
• Caring for the Eraser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
• Cleaning the Printer Head, Platen Roller and Pick-up Roller. . . . . . . . . . . . . . 75
• Replacing the Batteries in the Electronic Pen and the Electronic Eraser. . . . . 77
• Replacing the Cloth of the Electronic Eraser . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
• Meanings of Error Codes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
• Optional and Separately Available Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

Installation Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Help

Installation
7



For Your Safety

8

B
efore You Start
To prevent severe injury and loss of life, read this 
section carefully before using the unit to ensure proper 
and safe operation of your unit.

The following graphic symbols are used in this 
Operating Instructions manual.

Power and Ground Connection

The power source voltage of this unit is 
listed on the nameplate. Only plug the unit 
into an AC outlet with the proper voltage.
If you use a cord with an unspecified current 
rating, the unit or plug may emit smoke or 
become hot to the touch.

When you operate this product, the power 
outlet should be near the product and easily 
accessible.

For Your Safety

CLASS 1 LED PRODUCT

Denotes a potential 
hazard that could 
result in serious 
injury or death.
Denotes hazards 
that could result in 
minor injury or 
damage to the unit.

These symbols are used to 
alert operators to a specific 
operating procedure that must 
not be performed.
These symbols are used to 
alert operators to a specific 
operating procedure that must 
be emphasized in order to 
operate the unit safely.

For Users

WARNING

CAUTION

WARNING
To ensure safe operation the power cord 
supplied must be inserted into a standard 
three-prong AC outlet which is effectively 
grounded (earthed) through the normal 
wiring.

The fact that the equipment operates 
satisfactorily does not imply that the power 
point is grounded (earthed) and that the 
installation is completely safe. For your 
safety, if in any doubt about the effective 
grounding (earthing) of the power point, 
consult a qualified electrician.

If the plug cannot be inserted into the AC 
outlet, contact a licensed electrician to 
replace the AC outlet with a properly 
grounded (earthed) one.

Do not defeat the purpose of the grounding 
(earthing) plug (ex. do not use a conversion 
plug).

Plug the power cord firmly into an AC outlet. 
Otherwise, it can cause fire or electric 
shock.

Do not pull, bend, rest objects on, or chafe 
the power cord and plug. Damage to the 
power cord or plug can cause fire or electric 
shock.

Do not attempt to repair the power cord or 
plug. If the power cord or plug is damaged or 
frayed, contact an authorized service 
representative for a replacement.

Ensure that the plug connection is free of 
dust. In a damp environment, a 
contaminated connector can draw a 
significant amount of current that can 
generate heat and eventually cause fire if 
left unattended over an extended period of 
time.

Never touch the plug with wet hands. 
Danger of electric shock exists.



For Your Safety

B
efore You Start
Stop operation immediately if your unit emits 
smoke, excessive heat, abnormal smell or 
unusual noise. These conditions can cause 
fire or electric shock. Immediately turn the 
unit off and unplug the power cord, and 
contact your dealer for service.

When disconnecting the unit, grasp the plug 
instead of the cord. Pulling on a cord forcibly 
can damage it and cause fire or electric 
shock.

The unit should be used only with the power 
cord that is supplied by the manufacturer.
•(220–240 V equipment)
A certified power supply cord has to be 
used with this equipment. The relevant 
national installation and/or equipment 
regulations shall be considered. A certified 
power supply cord is not lighter than 
ordinary polyvinyl chloride flexible cord 
according to IEC 60227 (designation 
H05VV-F 3G 1.0 mm2).

Installation and Relocation

To prevent fire or shock hazard, do not 
expose this unit to rain or any type of 
moisture.

Operating Safeguards

If metal fragments or water gets into the unit, 
turn the unit off and unplug the unit 
immediately. Contact your dealer for service. 
Operating the contaminated unit can cause 
fire or electric shock.

Never open or remove unit covers that are 
screwed with screws unless specifically 
instructed in the “Operating Instructions”. A 
high-voltage component can cause electric 
shock.

Do not alter the unit or modify any parts. 
Alteration or modification can cause fire or 
electric shock.

Keep the marker’s cap or battery out of 
reach of children to prevent swallowing.
Battery

Be sure to use the specified type of batteries 
only. Using incorrect type of batteries can 
burn or leak.

Ensure that batteries are installed with 
correct polarity. Incorrectly installed batteries 
can burst or leak, resulting in spillage or 
injuries.

Be sure to take out batteries worn away from 
the unit. The battery worn away can leak.

Be sure that a battery should not be 
charged, shorted, heated, broken or thrown 
into fire. Using wrong can leak generate 
heat or burst.

Power

When the unit is not used over an extended 
period of time, switch it Off and unplug it. If 
an unused unit is left connected to a power 
source for a long period, degraded insulation 
may cause electric shock, current leakage or 
fire.

Installation and Relocation

Do not position the unit in a location where it 
is unstable.

Do not place the unit in a hot humid or dusty 
environment.
Prolonged exposure to these adverse 
conditions may cause fire or electric shock.

When moving the unit, be sure to unplug the 
power cord from the AC outlet. If the unit is 
moved with the power cord attached, it can 
cause damage to the cord which could result 
in fire or electric shock.

CAUTION
9



For Your Safety

1

Do not install the unit except by a qualified 
service personnel.

After installing or moving the electronic 
board, lock the casters and set the fall-
prevention extension legs.

Operating Safeguards

If the unit is fallen down or damaged, turn 
the unit off and unplug the power cord. 
Otherwise, it may cause fire or electric 
shock.

Do not put drinks, other liquids or heavy 
items on the tray or screen. Accidental 
spillage of liquid into the unit may cause 
severe damage. If this occurs, turn the unit 
off, unplug the power cord and contact your 
dealer for service.

Do not lean against the screen or on the 
cover (lower), even if the electronic board is 
mounted on the wall.

Battery

When the unit is not used over an extended 
period of time, take the batteries out of the 
unit. Otherwise, the batteries may leak. Do 
not use the leaked batteries.

Locking the casters
(Push this side)

Push to lock
0

Safety Information
This appliance is supplied with a moulded three pin 
mains plug for your safety and convenience.
A 5 amp. fuse is fitted in this plug. Should the fuse need 
to be replaced please ensure that the replacement fuse 
has a rating of 5 amps. and that it is approved by ASTA 
or BSI to BS1362. Check for the ASTA mark  or the 
BSI mark  on the body of the fuse. If the plug 
contains a removable fuse cover you must ensure that it 
is refitted when the fuse is replaced. If you lose the fuse 
cover the plug must not be used until a replacement 
cover is obtained. A replacement fuse cover can be 
purchased from your local Panasonic Dealer.
If the fitted moulded plug is unsuitable for the socket 
outlet in your home then the fuse should be removed 
and the plug cut off and disposed of safely.
There is a danger of severe electrical shock if the cut off 
plug is inserted into any 13 amp. socket.
If a new plug is to be fitted please observe the wiring 
code as shown below. If in any doubt please consult a 
qualified electrician.
WARNING: This appliance must be earthed.
IMPORTANT: The wires in this mains lead are coloured 
in accordance with the following code.

Green-and-Yellow: Earth
Blue: Neutral
Brown: Live

As the colours of the wire in the mains lead of this 
appliance may not correspond with the coloured 
markings identifying the terminals in your plug, proceed 
as follows.
The wire which is coloured Green-and-Yellow must be 
connected to the terminal in the plug which is marked 
with the letter E or by the Earth symbol  or coloured 
Green or Green-and-Yellow.
The wire which is coloured Blue must be connected to 
the terminal in the plug which is marked with the letter N 
or coloured Black.
The wire which is coloured Brown must be connected to 
the terminal in the plug which is marked with the letter L 
or coloured Red.

For users in the United 
Kingdom only

How to replace the fuse: 
Open the fuse 
compartment with a 
screwdriver and replace 
the fuse.
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efore You Start
Precautions

Installation • Do not install the unit where it may be exposed to direct sunlight, near heating equipment, or 
near air-conditioning vents as this may cause stretching and/or discoloration of the screen. 

• Do not install the unit in strong sunlight or strong lighting. Proper copying may become 
impossible.

• Do not install the unit in locations where the temperature may change suddenly as this may 
disable the unit’s ability to make copies.

Screen Film • Make thick and dark lines inside the copying area. 
Note that any writing inside the shaded area (on 
right) cannot be copied.

• Do not allow writing to remain on the screen for an 
extended period of time as it will become harder to 
erase.

• Do not erase with an overly dirty eraser (see page 
75).

• Periodically wipe the screen film gently with a 
water-dampened cloth that has been thoroughly wrung. (See page 75.)

• Use a commercially available white board cleaner for hard-to-erase stains. 
(SANFORD® EXPO® white board cleaner etc.)

• Do not touch the screen, write with markers, or erase while the screen is moving as this may 
result in damage to the unit.

• Do not attach chart paper to the screen film for copying as this may result in damage to the 
unit.

Markers, 
Erasers and 
Thermal 
Transfer Film

• Use only the included or designated markers, erasers and thermal transfer film. (See page 
82.)
Use of accessories other than those included or designated (such as oil-based 
markers) may damage the screen or result in hard-to-erase markings.

• Copy quality increases with the thickness of the drawn line. To ensure quality copies, please 
use the markers (big).

• The markers for interactive (small) draw thin lines. The quality of the copies may be reduced 
when these markers are used.

• Do not store the thermal transfer film in a location subject to extreme changes in 
temperature (such as near air conditioning or heating equipment) as this may cause 
condensation on the thermal transfer film and result in poor print quality and/or paper jams.

• Store markers horizontally as vertical storage may stop the ink from coming out.
• The length of one roll of designated thermal transfer film (Replacement film: UG-6001) is 

approximately 50 meters (164 ft.). One roll of thermal transfer film can make approximately 
150 sheets of copies.
Note that the total number of copies may differ depending on the operating conditions.
Also note that the length of the thermal transfer film supplied with the unit is shorter 
than the replacement film roll and is only approximately 10 meters (32.8 ft.).

Power Cord 
and USB 
Cable

• When moving the unit, disconnect the power cord from the electrical power socket and from 
the printer’s power connector, and disconnect the USB cable from the printer’s USB 
connector and a computer. Then coil them for transportation as stepping on the power cord 
and USB cable or having them catch on something during movement may result in damage 
to the cord and cable.

• If you connect the electronic board to a USB hub, it is not guaranteed to work.
• Do not connect two or more Panasonic electronic boards to a computer. It may cause the 

computer operation to become unstable.

25 mm (1" )

35 mm

25 mm (1" )

(1 3/8" ) (1 3/8" )
35 mmCopying area
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Replacing 
the Thermal 
Transfer Film

• Dispose of the used thermal transfer film in a trash receptacle for burnable trash.
• A negative of the copied image will remain on the thermal transfer film. (To protect the 

security of your information, we recommend cutting up the used thermal transfer film with 
scissors or shredder before disposing of it.)

Electronic 
Pen and 
Electronic 
Eraser

• Do not cover the transmitter with your hand while using an interactive function as this may 
cause the position of the Electronic Pen or the Electronic Eraser not to be normally 
detected.

• Press down firmly with the point of the Electronic Pen or the eraser cloth of the Electronic 
Eraser on the screen film until you hear a buzzing sound, and then move it slowly. 
However, do not press down the point of the Electronic Pen too much strongly as this may 
make a dent in the screen back panel.

• Do not use two or more the Electronic Pens or the Electronic Eraser at the same time as this 
may cause the position of the Electronic Pen or the Electronic Eraser not to be normally 
detected.

• For precise positioning, keep the Electronic Pen and Electronic Eraser perpendicularly to 
the screen during use.

• Since ultrasonic is used to detect the position of the Electronic Pen and Electronic Eraser 
when they are being used, you may hear a buzzing sound, but this is not harmful to the 
human body or peripheral hardware. It will also not result in an electric shock.

Transmitter

NG OK
2
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Battery If batteries are used improperly, batteries may leak, causing corrosion of the unit, or they may 
burst. To prevent this, always follow the precautions given below.

• Always remove batteries from the Electronic Pen and Electronic Eraser if they are not to be 
used for an extended period of time.

• Use the same type of batteries. Do not mix different types.
• Do not mix old and new batteries.
• Always insert batteries with their polarity properly oriented as indicated on the Electronic 

Pen or Electronic Eraser.
• If the Electronic Pen or Electronic Eraser ceases to function because batteries have run out, 

remove them immediately and dispose of them according to local regulations. 
Leaving drained batteries in the Electronic Pen or Electronic Eraser may result in leakage.

• Do not disassemble batteries or place them in a fire.
• Do not short batteries.
• Alkaline batteries cannot be recharged. Never attempt to recharge alkaline batteries.

Projector • Light from the projector may enter the eye when using a projector to project images for the 
purpose of making presentations and so on. Be very careful as direct projector light may 
hurt the eyes.

Após o uso as pilhas / baterias contidas neste produto 
poderão ser dispostas em lixo doméstico.

For Brasil

For Taiwan ( 台灣 )
13



Precautions

1

To prevent the CD-ROMs from accidental damages:

CD-ROM

Do not touch or write on the surface 
of the disc.

Do not leave the disc out of the 
protective case.

Do not leave the disc in direct 
sunlight or near heat sources.

Do not place heavy objects on the 
disc case or drop the case.

To clean the disc, hold the disc by 
its edges and wipe it from the 
center to the edges with a dry, soft 
cloth.
4



Part Names and Functions

B
efore You Start
Part Names and Functions

ON

OFF

Screen

AC Inlet

Power Switch

Tray

Power Cord

Output Port
This port holds up to 10 
sheets of output paper.

Paper Cover
Open this cover to 
load copy paper.

Printer Door
Open this door to load a 
thermal transfer film or to 
remove jammed paper.
(See pages 18, 22, 23.)

Printer Open Lever
Push down this lever to 
open the printer door.

Control Panel
(See page 16 for 
details.)

USB Connector
(See page 27.)

Cord Holder

Printer

Electronic Pen / 
Electronic Eraser 
Position Receiver

Electronic Pen / 
Electronic Eraser 
Position Receiver

Scanner
15



Part Names and Functions

1

l

Control Panel

Panel Name Description

Contrast/
Remaining 
Film 
Indicator

This lamp indicator notifies the user when the time to replace the thermal transfer 
film is approaching (estimated) and of the printing contrast used during copying.
Indicator off: Normal printing contrast
Indicator on: Darker than normal printing contrast
Indicator flashing*: Almost time to replace the thermal transfer film

(Note that only about 15 more sheets may be 
copied when this indicator starts flashing.)
Replacement film (UG-6001) is separately available 
from the dealer where you purchased your unit.

* The flashing indicator will go out after the power is turned off, or the 
printer has been opened and closed. (When copying is performed, this 
indicator will begin flashing again.)

Contrast 
Key

Each time this key is pressed, the unit will alternate between normal and dark 
contrast modes (Normal/Dark).

2-Screen 
Copy Key

This key causes the front and back of the screen to be copied on a single 
sheet of paper.

Multi-Copy/
Error 
Indicator

This indicator displays the number of copies to be made. The display changes 
each time the Multi-Copy/Stop Key is pressed.

Example: 1 →  2 →  ··· →  9 → 1 →  ···
When an error occurred, a flashing symbol will appear on this display to 
indicate the error status. (See page 80.)

Multi-Copy/
Stop Key

When making multiple copies, press this key until the desired number of 
copies is displayed on the Multi-Copy/Error Indicator. 
This key can also be pressed to stop copying while executing multiple copies. 
• The display changes as shown below each time the screen is copied. After 

reaching 0, the display will reset to 1.
Example for multiple copies:
5 →  4 →  3 →  2 →  1 →  0 →  1 (Number is counted down.)

Copy Key This key causes the screen to be copied.

Advance 
Key

Pressing this key advances the screen from right to left.

Contrast/Remaining Film
Indicator

Advance Key

Multi-Copy/Error Indicator
Multi-Copy/Stop Key

Copy Key

Contrast Key
2-Screen Copy Key
6



Part Names and Functions

B
efore You Start
■ Electronic Pen (see page 25)

* When using the projector mode to operate the computer screen on the Interactive Panaboard screen and operating 
the pen while holding down the pen button achieves the same function as pressing the right mouse button.

■ Electronic Eraser (see page 26)

Electronic Pen and Eraser

Pen holder lever

Pen button*

Eraser cloth

Eraser cover
17



Installing the Thermal Transfer Film

18
U
sing
Install the thermal transfer film in the printer.

1 Set the power switch to on ( I ).

• “ ” will flash on the Multi-Copy/Error 
Indicator when the thermal transfer film has 
run out.

•The screen will move to home position and 
stop.

2 Push down the printer open lever and open 
the printer door.

3 Install the thermal transfer film.

1) Set the thermal transfer film, with the blue 
gear in front, on the right.

Installing the Thermal 
Transfer Film

ON

OFF

Printer door

Blue gear
2) Insert the blue shaft into the front left hole.

3) Place the blue gear on the front right groove.

4) Place the white shaft on both sides of the back 
grooves.

Blue shaft

Blue gear

White shaft



Loading Copy Paper

U
sing
4 Tighten the film, then close the printer door.

1) Rotate the blue gear in the direction of the 
arrow to take up the slack on the film.

• If a slack remains, perform step 3-2) through 
4-1) again.

2) Securely close the printer door by using both 
hands until a click is heard.

• “ ” flashing on the Multi-Copy/Error 
Indicator will go out.

Note
• If “ ” is still flashing after closing the printer 

door, make sure that the thermal transfer film 
has been installed properly and tightened.

•The printer door should be closed to make 
copies properly. Confirm both latches are 
locked.

Blue gear

Latches
It is possible to load up to 40 sheets of A4 (Letter*) 
size copy paper [assuming a paper weight of 80 g/m2 

(20 lb.)].
Note that only A4 (Letter*) size paper may be used.
When the unit is first used or when “ ” flashes on the 
Multi-Copy/Error Indicator to indicate that the unit is 
out of paper, load copy paper as described below.

* Letter size is for U.S.A. and Canada models.

Notes on Loading Copy Paper

Follow the guidelines below to ensure smooth and 
accurate printing by the unit.

• Only use A4 (Letter) size copy paper having a 
weight of 60 g/m2 (16 lb.) to 90 g/m2 (24 lb.) as the 
copy paper for this unit.

• Do not simultaneously load paper of varying type 
and thickness as this may result in paper jams.

• Before adding copy paper, be sure to remove all the 
copy paper remaining inside the unit’s paper cover. 
(Note that copy paper will slightly resist being 
removed, but may be pulled out without problems.)
After removing the copy paper, stack the removed 
paper together with the new paper, fan it thoroughly, 
square it and reload.

• Extremely smooth or glossy paper
• Coated paper
• Thermal paper
• Paper that is printed on one side
• Wrinkled paper, creased paper, etc.

1 Set the power switch to on ( I ).

• “ ” will flash on the Multi-Copy/Error 
Indicator when copy paper has run out.

•The screen will move to home position and 
stop.

Loading Copy Paper

DO NOT USE THE FOLLOWING TYPES 
OF PAPER

ON

OFF
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Loading Copy Paper

2

2 Pull the paper cover forward as shown in the 
figure.

3 To prevent paper jams such as those caused 
by multiple sheets feeding at once, fan the 
paper thoroughly, square it, align it with the 
guide inside, and insert as far as it will go.

Note
•Only use A4 (Letter*) size copying paper 

having a weight of 60 g/m2 (16 lb.) to 90 g/m2 
(24 lb.) as the copy paper for this unit.
* Letter size is for U.S.A and Canada models.

•Do not stack more copy paper in the unit 
than the maximum paper limit indicated by 
the guide (see the above figure) as this may 
result in paper jams. [Note that the unit can 
hold about 40 sheets of paper having a 
weight of 80 g/m2 (20 lb.).]

Maximum paper limit

Guide
0

4 Close the paper cover until a click is heard.

Note
•Close the paper cover, or the unit will not 

work properly.
•The paper cover should be closed to make 

copies properly. Confirm the both latches are 
locked.



Making Copies

U
sing
This section describes how to copy text and 
illustrations drawn on the screen.

1 Set the power switch to on ( I ).

• “ ” will light on the Multi-Copy/Error 
Indicator to indicate that the unit is ready to 
copy.

• The screen will move to home position and 
stop.

2 Press the  (Copy Key).

•Text and illustrations on the screen will be 
copied and copies emerge from the output 
port.

•The output port can hold up to 10 sheets of 
copy paper. (Note that exceeding the output 
port’s capacity may result in paper jams.)

•For details on making multiple copies and so 
on, refer to “Copy Types and Procedures” on 
this page.

Making Copies

ON

OFF
Note
•Do not use paper that has been copied on 

one side by this printer as copy paper in this 
unit or in any other copiers or printers as this 
may result in dirty rollers, degradation of 
printing quality, paper jams, and streaks and 
smudges on output paper.

•Copy quality increases with the thickness of 
the drawn line. To ensure quality copies, 
please use the markers (big).

•The markers for interactive (small) draw thin 
lines. The quality of the copies may be 
reduced when these markers are used.

•Do not write on the back side of the output 
paper from this unit. The printed ink may be 
transferred underneath the paper.

•Text or images in shades of yellow will not 
copy.

[A] Copying the front of the screen

1) Press .

[B] Copying the back of the screen

1) Press  to move the screen to be copied 
to the front.

2) Press .

[C] Making multiple copies (up to 9)

1) Select the number of copies (1 to 9) by 
pressing  as necessary.

2) Press .

• Press  to stop copying in mid-operation.

[D] Making 2-screen copies
Copying the front and back of the screen on a 
single sheet of paper 

1) Press .

Copy Types and Procedures
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Replacing the Thermal Transfer Film

2

The unit is capable of producing about 15 more copies 
when the Contrast/Remaining Film Indicator begins to 
flash. The unit has run out of thermal transfer film and 
can no longer make copies when the Multi-Copy/Error 
Indicator flashes “ ”. Separately available 
replacement film (UG-6001) may be purchased from 
the dealer where you purchased the unit. Thermal 
transfer film is replaced as follows.

Notes on Replacing Thermal 
Transfer Film

• Only use the designated product (UG-6001) from 
Panasonic as the replacement film. (Note that using 
another type of replacement film may result in 
degraded printing quality or damage to the unit.)

• Thermal transfer film is disposable. Dispose of used 
thermal transfer film as “burnable” or “non-
recyclable” rubbish.

• A negative of the copied image will remain on the 
thermal transfer film. To protect the security of your 
information, we recommend cutting up the used 
thermal transfer film with scissors or shredder before 
disposing of it.

1 Push down the printer open lever to open the 
printer door, and remove the used film.

2 Refer to steps 3 and 4 in the section of 
“Installing the Thermal Transfer Film” on page 
18.

Replacing the Thermal 
Transfer Film
2

Note
• If “ ” is still flashing after closing the printer 

door, make sure that the thermal transfer film 
has been installed properly and tightened.

•The printer door should be closed to make 
copies properly. Confirm both latches are 
locked.



Paper Jams

U
sing
Remove paper jams by the following procedure when 
copy paper does not come out of the output port or 
when “ ” flashes on the Multi-Copy/Error Indicator.

1 Push down the printer open lever to open the 
printer door.

2 Remove the thermal transfer film with both 
hands.

3 Remove the jammed paper.

Paper Jams

Jammed paper
4 Install the thermal transfer film.

•Refer to steps 3 and 4 in the section of 
“Installing the Thermal Transfer Film” on 
page 18.

• “ ” flashing on the Multi-Copy/Error 
Indicator will go out.

Note
• If “ ” is still flashing after closing the printer 

door, make sure that the thermal transfer film 
has been installed properly and tightened.

•The printer door should be closed to make 
copies properly. Confirm both latches are 
locked.

If the flashing “ ” does not go out after the foregoing 
procedure has been performed; this may indicate that 
the paper feeder is not functioning properly.
Reload the copy paper by following the steps given 
below.

1 Turn the power off.

2 Open the paper cover and remove all the copy 
paper remaining inside the unit’s paper cover.

Note
•The copy paper will slightly resist being 

removed, but may be pulled out without 
problems.

ON

OFF
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Paper Jams

2

3 To prevent paper jams such as those caused 
by multiple sheets feeding at once, fan the 
paper thoroughly, square it, align it with the 
guide inside, and insert as far as it will go.

Note
•Do not stack more copy paper in the unit 

than the maximum paper limit indicated by 
the guide (see figure) as this may result in 
paper jams. [Note that the unit can hold 
about 40 sheets of paper having a weight of 
80 g/m2 (20 lb.).]

4 Close the paper cover until a click is heard.

Note
•Close the paper cover, or the unit will not 

work properly.
•The paper cover should be closed to make 

copies properly. Confirm the both latches are 
locked.

Maximum paper limit

Guide
4

5 Turn the power on.

• “ ” will light on the Multi-Copy/Error Indicator 
to indicate that the unit is ready to copy.

•The screen will move to home position and 
stop.

ON

OFF



Setting the Electronic Pen and Eraser

U
sing
1 Remove the battery cover on the pen holder, 
insert the batteries as shown in the figure, and 
re-attach the battery cover.

•Always use “LR03 (AAA size)” (alkaline) 
batteries and be sure that their polarity is 
properly oriented.

•Do not mix old and new, different type 
batteries when replacing batteries.

2 Remove the temporal cap, and set the cap 
and adaptor to the marker for interactive.

•Securely push the adaptor into the marker 
for interactive as far as it will go.

•Do not remove the color identification cap on 
the back end of the marker.

Setting the Electronic 
Pen and Eraser

Setting the Electronic Pen

Battery cover

Pen holder

2

3
1

Marker for interactive
Remove the 
temporal cap.

Adaptor
Cap

Color identification 
cap

2
3

1

3 Rotate the pen holder lever to the release 
position, insert the marker for interactive, and 
then return the pen holder lever to the lock 
position.

•Lock the pen holder lever while inserting the 
marker all the way into the pen holder until 
you hear a buzzing sound. 
Detection of the marker color may not work 
well unless the marker is inserted fully into 
the pen holder.

•Do not set the marker near the Interactive 
Panaboard while using the interactive 
function as this may appear unnecessary 
streaks not written on the computer screen.

Note
•Press down firmly with the point of the 

Electronic Pen on the screen film until you hear 
a buzzing sound.

•For precise positioning, keep the Electronic 
Pen perpendicularly to the screen during use. 
Inclined pen angle will cause the shift of 
position.

Inserting
Locking

Releasing

Pen holder lever

2 - 3 mm
(1/16" - 2/16")

Marker for
interactive

2
3

1

25



Setting the Electronic Pen and Eraser

2

1 Remove the eraser cover, insert the batteries 
as shown in the figure, and re-attach the 
eraser cover.

• Always use “LR03 (AAA size)” (alkaline) batteries 
and be sure that their polarity is properly oriented.

• Do not mix old and new, different type batteries 
when replacing batteries.

Note
•Press down firmly with the eraser cloth of the 

Electronic Eraser on the screen film until you 
hear a buzzing sound.

Setting the Electronic Eraser

Eraser cover

Electronic
eraser

2

3

1

4

6

1 Remove the eraser cloth by pushing through 
the hole in the Electronic Eraser.

2 Attach a new eraser cloth by pressing around 
the edge.

Replacing the Eraser Cloth

Hole

Eraser cloth

Press

New eraser cloth



Installing Drivers and Software

U
sing
Drivers and software must be installed in your 
computer to use the interactive function, printer and 
TWAIN driver.
For the information of the interactive function and 
Panasonic-DMS, refer to “Features” on page 4.

*1 This electronic board does not function with Hi-Speed 
USB 2.0. Even if using a computer equipped with Hi-
Speed USB 2.0, this electronic board functions with 
Full Speed USB 2.0.

*2 Microsoft Windows 98 operating system 
(hereafter Windows 98)

*3 Microsoft Windows Millennium Edition operating 
system (hereafter Windows Me)

*4 Microsoft Windows 2000 operating system 
(hereafter Windows 2000)

*5 Microsoft Windows XP operating system 
(hereafter Windows XP)

Installing Drivers and 
Software

System Requirements

Computer IBM PC/AT or compatible machine 
with a CD-ROM drive

CPU Pentium® II or higher processor

Interface USB 2.0 or USB 1.1*1

OS Windows® 98*2 / Windows Me*3 / 
Windows 2000*4 / Windows XP*5

Memory

64 MB or more (Windows 98 / 
Windows Me)
128 MB or more (Windows 2000)
256 MB or more (Windows XP)

HD At least 100 MB free space (except 
saving space for data files)
The provided CD-ROM includes the following.

• USB driver
• Printer driver

The printer driver allows the printer to print 
documents from your computer.

• TWAIN driver
• Panasonic-DMS software

Panasonic Document Management System 
(Panasonic-DMS) uses the TWAIN driver to scan 
images drawn on the screen. The Panasonic-
DMS has a capability of managing documents 
(image files).

• Interactive Panaboard Software
In order to use the interactive functions, it is 
necessary to install the Interactive Panaboard 
Software. The software cannot be used with the 
TWAIN driver.

• Panasonic-DMS manual
• Interactive Panaboard operating instructions

Notes when connecting the 
electronic board to a computer

• First install the USB, printer and TWAIN driver to 
your computer, then connect the electronic board 
to the computer (refer to “Installing Drivers / 
Interactive Panaboard Software”).

• If you connect the electronic board to a USB hub, 
it is not guaranteed to work.

• Do not connect two or more Panasonic electronic 
boards to a computer. It may cause the computer 
operation to become unstable.

• Use the USB cable provided with the unit.

Contents of CD-ROM
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Installing Drivers and Software

2

The USB, printer, TWAIN driver and Interactive 
Panaboard Software are installed in your computer 
by following procedures.

Note
•Do not yet connect a USB cable to the 

electronic board.

1 Power on your computer and start Windows*1.

•Log on as an administrator for Windows 2000 
or Windows XP.

*1 Microsoft Windows operating system 
(hereafter Windows)

2 Insert the CD-ROM into the CD-ROM drive. 
The Setup window appears automatically.

•Depending on the operating system or the 
settings that you are using, the Setup 
window may not appear automatically.
In such a case, execute “Menu.exe” in the 
CD-ROM from the Explorer.

3 When “Welcome” window appears, click 
[Next].

4 Click [Interactive Panaboard Setup].
•To install the Panasonic-DMS software, click 

[Panasonic-DMS] (see page 30).

•To read the operating instructions in the 
provided CD-ROM, the Adobe Reader or 
Acrobat Reader must be installed in your 
computer. It can be downloaded from the 
Adobe's Web site if Internet is available.

Installing Drivers / Interactive 
Panaboard Software
8

5 Click [Install Software].

6 Read ”End-User License Agreement” carefully 
and click [Yes].

7 When the following window appears, check 
that the electronic board is not connected to 
your computer and click [OK].
• If the USB cable is connected to the 

electronic board, remove it and click [OK].

•For Windows 98 or Windows Me, a floppy 
disk or CD-ROM for installing the operating 
system may be required.

• If the screen prompts to restart Windows, 
restart Windows.



Installing Drivers and Software

U
sing
8 When the following window appears after files 
are copied, power the electronic board on, 
and connect the USB cable provided from the 
electronic board to your computer.

9 Follow the on-screen instructions if the wizard 
windows appear.

• If the wizard window is displayed to select 
the file (##.inf) for the printer driver in 
Windows XP, select “windows\inf\oem##.inf”.

• If the wizard window is displayed to connect 
to the Windows Update in Windows XP SP2, 
select [No].

• If the warning window is displayed in 
Windows 2000 / Windows XP, select [Yes] or 
[Continue Anyway] to continue the 
installation.

•The new hardware wizard windows may be 
displayed several times depending on the 
operating system.

•For Windows 98 or Windows Me, a floppy 
disk or CD-ROM for installing the operating 
system may be required.

10 When the installation is completed, click [OK].

• Interactive Panaboard group is registered 
in the Panasonic of the Programs menu.

•The following is installed in the Interactive 
Panaboard group.
- Interactive Panaboard (application)
- Interactive Panaboard Help
- Interactive Panaboard Uninstall
- Operating Instructions
Note
• If the electronic board is powered on with 

connecting the USB cable when the 
installation is completed and [Exit] is clicked 
in the setup window, the Interactive 
Panaboard Software is automatically started 
in Windows 2000 / Windows XP. 
(For the detailed information, refer to 
“Starting the Interactive Panaboard 
Software” on page 33.)
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Installing Drivers and Software

3

When Panasonic-DMS is already installed, leave it 
(do not uninstall it) and install the new software in 
the same folder to overwrite it.

1 Power on your computer and start Windows.

•Log on as an administrator for 
Windows 2000 or Windows XP.

2 Insert the CD-ROM into the CD-ROM drive.
The Setup window appears automatically.

•Depending on the operating system or the 
settings that you are using, the Setup 
window may not appear automatically. 
In such a case, double-click “Menu.exe” in 
the CD-ROM from the Explorer.

3 When “Welcome” window appears, click 
[Next].

4 Click [Panasonic-DMS].
•To install the USB, printer, TWAIN driver and 

Panasonic Interactive Software, click 
[Interactive Panaboard Setup] (see page 
28).

•To read the operating instructions in the 
provided CD-ROM, the Adobe Reader or 
Acrobat Reader must be installed in your 
computer. It can be downloaded from the 
Adobe's Web site if Internet is available.

Installing the Panasonic-DMS 
Software
0

5 Click [Install Panasonic-DMS Software].

6 Click [Install].
•To install the Panasonic-DMS Manual, check 

the [Operating Instructions] check box.

7 Read “End-User License Agreement” carefully 
and click [Yes].

8 Follow the on-screen instructions when 
messages appear.

9 When the setup process is completed, restart 
Windows.
•About the Panasonic-DMS, refer to the 

Document Management System operating 
instructions in the CD-ROM.



Installing Drivers and Software

U
sing
If you need to remove the USB driver, printer driver, 
TWAIN driver and Interactive Panaboard Software, 
perform the following steps.

1 Power on your computer and start Windows.

•Log on as an administrator for 
Windows 2000 or Windows XP.

2 Click [Start], and then click Control Panel in 
Settings.

•For Windows XP, click [start], and then click 
Control Panel.

3 Double-click Add / Remove Programs icon 
(Windows XP: Add or Remove Programs) in 
the Control Panel.

4 Select Panaboard UB-8 Software in the Add 
/ Remove Programs list, and click [Add / 
Remove].

5 Follows the instructions on the screen.

6 After uninstalling, restart your computer.

Removing Drivers / 
Interactive Panaboard 
Software
 If you need to remove the Panasonic-DMS software, 

perform the following steps.

1 Power on your computer and start Windows.

•Log on as an administrator for 
Windows 2000 or Windows XP.

2 Click [Start], move the pointer to Programs–
Panasonic–Panasonic Document 
Management System–Uninstall.
(For Windows XP, All Programs instead of 
Programs.)

3 Click [OK].

4 After uninstalling, restart your computer.

Removing the Panasonic-
DMS Software
31



Using the Panaboard in Projector Mode

3

• When using a projector to project images, be sure to display the image so that it is centered left-to-right on the 
Interactive Panaboard screen and with at least a 50 mm  (2”) gap between the top of the image and the screen 
border. Note that the Electronic Pen does not always operate properly when within 50 mm (2”) of the top of the 
screen, 100 mm (3 15/16”) of the position receiver and 35 mm (1 3/8”)  from the both sides of the screen.

• Since the Electronic Pen position may shift if the image on the screen is trapezoid, adjust the projector so that the 
image on the screen is rectangular.

• When projecting an image on the Interactive Panaboard using a projector, the image on the screen may become 
difficult to see depending on the viewing angle and position due to reflected projector light. If this happens, adjust 
the location of the projector or change your viewing position.

• When using a projector to project a computer screen, be sure to use optimum resolution settings for the projector 
and the computer. The image may be difficult to see if optimum settings are not used. Fine lines in the image on 
the Interactive Panaboard screen may appear broken particularly if the projector resolution is lower than the 
computer resolution.

• When using a projector to project images, the Electronic Pen position may shift if the projection position shifts due 
to the following causes. If this happens, it becomes necessary to perform calibration to reposition the projected 
image on the screen. (For details on calibration, see page 33.)
- When the installed location of the projector is changed.
- When the position of the Interactive Panaboard is changed.
- When the projection area and position has changed due to using a projector function such as zoom.
- When the display resolution of the projector or computer has changed. 
Note that the position of an Interactive Panaboard attached to a stand may shift if it is struck carelessly.
Always make sure the stand's casters are locked in place.

• Light from the projector may enter the eye when using a projector to project images for the purpose of making 
presentations and so on. Be very careful as direct projector light may hurt the eyes.

Using the Panaboard in Projector Mode

Precautions When Using a Projector

50 mm (2")

Position receiver

Position receiver

Interactive
upper limt mark

Interactive
upper limt mark

* Do not use the shaded area.

Screen film

100 mm (3 15/16")

100 mm
(3 15/16")

35 mm (1 3/8")

35 mm
 (1 3/8")

Projector
2



Using the Panaboard in Projector Mode

U
sing
1 Turn on the Interactive Panaboard.

2 Turn on your computer and start up Windows.

3 For Windows 2000 / Windows XP
Connect the USB cable provided from the 
electronic board to the computer.
•The Interactive Panaboard Software is 

automatically started.
For WIndows 98 / Windows Me
Click [Start] and select Programs - 
Panasonic - Interactive Panaboard - 
Interactive Panaboard.
•The window appears to show the Interactive 

Panaboard is detected.

Note
• If the Panaboard Operation Panel is 

displayed using the Panasonic-DMS, the 
Panasonic Interactive Software cannot be 
started. Close the Panaboard Operation 
Panel and start it. Refer to page 72.

•To change the setting so the Interactive 
Panaboard Software is not started 
automatically when connecting the USB 
cable, perfrom the following.

(1) Connect the USB cable provided from the 
electronic board to the computer.

(2) Click [Start] and select Settings - 
Control Panel, then double-click 
Scanners and Cameras icon. 
(For Windows XP, click [start] and select 
Control Panel)

(3) Double-click Panaboard-UB8 USB 
Device Driver icon and click the Disable 
device events check box in the Events 
tab. Click [OK].

To start the Interactive Panaboard Software, 
click [Start] and select Programs - 
Panasonic - Interactive Panaboard - 
Interactive Panaboard.
(For Windows® XP, All Programs instead of 
Programs)

4 Click [OK].

•The Select Mode window appears.

Starting the Interactive 
Panaboard Software
5 Click Projector icon and click [OK].

•The calibration start screen is displayed.
• If the Interactive Panaboard and projector 

are fixed not to move, then the calibration 
has been performed, it enables to skip the 
following calibration step by checking the 
Use the last Calibration setting check box. 

If the Desktop resolution is different from the 
setting when the calibration was executed 
before, Interactive Panaboard Software will 
not function properly. In that case, calibrate 
from the pop-up menu of the Taskbar. (See 
page 34.)

 

6 To calibrate the position of the computer 
screen, press the center of each corner for 
about two seconds in the following order with 
the Electronic Pen.

•When a position ended correctly, then the 
next position starts automatically.

•When the calibration ended correctly, the 
message is displayed to notify it.

1

4

2

3
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•When the calibration is 
completed and the Projector 
mode become active, the icon 

 will be registered in the 
Taskbar and the Desktop 
Drawing Tool will appear 
automatically.

[Desktop Drawing Tool]

Note
• If the Interactive Panaboard is not detected, 

the following notification window appears. 

In this case, check the status of the 
Interactive Panaboard and confirm that the 
USB cable is connected. For details on the 
settings of the communications port, refer to 
“Setting the Communication Port” on page 
35.

• If the Interactive Panaboard Software is used 
without connecting the Interactive 
Panaboard, click [Offline] in the notification 
window. In the off-line state, a file recorded in 
Projector mode can be played back and 
edited.

•The tool tip text displayed when the mouse is 
located over the icon  in the Taskbar 
allows you to determine the current mode.
- Projector mode: “Interactive Panaboard 

(Projector)”
- Whiteboard mode: “Interactive Panaboard 

(Whiteboard)”
4

■ Exiting the Interactive Panaboard 
Software

Right-click the icon  in the Taskbar and click Exit 
in the pop-up menu.

Right-click the icon  in the Taskbar to display the 
pop-up menu.
Following operations are possible in the pop-up menu.

Select Mode...: (see page 35)
Switches the mode; Projector mode or 
Whiteboard mode.

Calibrate: (see page 33)
Executes the calibration.

Tool: (see page 40)
Draw: 
Displays the Desktop Drawing Tool (see page 
40).
On-Screen Keyboard:
Displays the On-Screen Keyboard (see page 
43).
View Window: 
Displays the View Window (see page 39).

Settings:
Communication Port...: 
Sets the communication port (see page 35).
Adjustment...: 
Adjusts the position of the Electronic Pen or 
Electronic Eraser to improve the shifted 
position (see page 36).
Options...: 
Sets the option of the Interactive Panaboard 
Software (see page 36).

Help Topics...:
Displays the help of the Interactive Panaboard 
Software.

About...:
Displays the Interactive Panaboard Software 
version information.

Exit:
Exits the Interactive Panaboard Software.

Pop-up Menu Configuration
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■ Switching the Mode

You can freely switch the Projector mode and the 
Whiteboard mode while the Interactive Panaboard 
Software is running.

1 Right-click the icon  in the Taskbar and 
click Select Mode... in the pop-up menu. In 
addition, you can double-click the icon in the 
Taskbar.

•The Select Mode window appears.

2 Click Projector or Whiteboard icon, and then 
click [OK].

Note
•When switching to the Projector mode, the 

calibration screen will not be displayed 
automatically after calibration ended 
correctly once. Calibrate if necessary.

•When switching to the Whiteboard mode, the 
Whiteboard window will be displayed.

■ Setting the Communication Port

Specifies the communication port to communicate 
with the Interactive Panaboard.

1 Right-click the icon  in the Taskbar and 
click Settings - Communication Port... in the 
pop-up menu.

•The Communication Port window appears.
2 Click [Start...] of the Auto Detection to detect 
the communication port connected with the 
Interactive Panaboard automatically.

3 Click [OK].

Note
•The COM Port can be selected for older 

models of the Interactive Panaboard without 
USB port.
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■ Adjusting the Shifted Position

The Electronic Pen or Electronic Eraser position may 
largely shift by the using environment. In this case, 
adjust the position according to the following 
procedures to improve the shifted position.

1 Right-click the icon  in the Taskbar and 
click Settings - Adjustment... in the pop-up 
menu.

•The Adjustment window appears.

2 Place the Electronic Pen at the center of the 
Interactive Panaboard screen and drag slowly 
the Electronic Pen downward about 100mm (4”).

•When the adjustment is finished, the 
adjustment end message will be displayed in 
the Adjustment window and [Cancel] will be 
changed into [OK].

3 Click [OK].

Note
•For precise adjusting, keep the Electronic 

Pen perpendicularly to the Interactive 
Panaboard screen during the adjustment. 
Inclined pen angle will cause the shift of 
position.

•To cancel the adjustment, click [Cancel] by a 
mouse of the computer.
6

■ Setting Options

Specifies the option of the Interactive Panaboard 
Software.

1 Right-click the icon  in the Taskbar and 
click Settings - Options... in the pop-up 
menu.

•The Options window appears.

2 The following options can be set.

•Show Desktop Drawing Tool when 
Projector Mode starts:
The Desktop Drawing Tool is automatically 
displayed after the Projector mode starts by 
checking the check box.

•Print out image automatically rotates to fit 
printer paper direction:
The printing image automatically rotates to fit 
the direction of paper set in the printer of the 
Interactive Panaboard by checking the check 
box.

•Original Keyboard:
The original keyboard of the Interactive 
Panaboard Software is used as the virtual 
keyboard. (See page 43.)

•Windows Keyboard:
The On-Screen Keyboard provided with 
Windows is used as the virtual keyboard. 
(See page 43.) 

* The Windows Keyboard can be used only 
with Windows Me, Windows 2000 or 
Windows XP.
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•JPEG:
Sets the quality level when exporting a page 
as a JPEG format image file. The larger 
number will get higher quality for the image 
file than small number when exporting. 
However, the file size will be large.

•TIFF:
When exporting a page as a TIFF format, an 
image file is compressed by checking the 
Compression (PACKBITS) check box.

•Save file automatically, named with the 
date:
The image file will be saved automatically as 
a file named with the date of capture by 
checking the check box.

•Save Folder:
Sets the default folder when saving image 
files.

•File Format: 
Sets the default format when saving image 
files.

•Display save verification dialog box: 
Displays a dialog box to verify the image file 
name by checking the check box.

• (Method 1) Draw strokes and record after 
verifying the background image:
After the background image is decided, 
drawing with the marker and eraser are 
recorded as an IPB document.

• (Method 2) Record strokes and 
background image together:
Records the background image as an IPB 
document at the same time as drawing with 
the marker and eraser.

•Desktop Drawing Tool: Drawing Data File:
Specifies the folder to save the drawing data 
if drawing data files for PowerPoint®*1 Slide 
Show is saved other than the folder of the 
PowerPoint file.

*1 Microsoft® PowerPoint® presentation 
graphics program (hereafter PowerPoint)

3 Click [OK].
This section explains the basic operations when using 
the Interactive Panaboard Software in Projector 
mode. We recommend trying the operations in 
accordance with the following steps to help you 
completely understand the operations in Projector 
mode.

• For any explanations on the operations of the 
Projector mode, the Electronic Pen will be referred 
to as “Mouse” and the projected computer screen on 
the Interactive Panaboard will be referred to as 
“Desktop”.

Step1: Using the Electronic Pen as 
a mouse

To start the Interactive Panaboard Software, see page 33.

1 If the Desktop Drawing Tool is not displayed, 
right-click the icon  in the Taskbar and 
click Tool - Draw to display the Desktop 
Drawing Tool.

2 To use the Electronic Pen as a mouse, click 
 (Arrow) in the Desktop Drawing Tool.

• In Projector mode, use the Electronic Pen 
with its cap on.

Operations of “click” and “drag” are as follows.
Single click: 

Press the projected screen with the tip of the 
Electronic Pen.

Double-click: 
Double-click is executed by performing two 
quick clicks at the same position with the tip 
of the Electronic Pen.

Drag: 
While pressing the desired image with the 
tip of the Electronic Pen, drag the image to 
its new position.

Right-click: 
While pressing the button of the Electronic 
Pen, press the projected screen with the tip 
of the Electronic Pen and release. (Do not 
release the button of the Electronic Pen 
before all of these operations are finished.)

For more details about the Desktop Drawing 
Tools, refer to “Using the Desktop Drawing 
Tool” on page 40.

Basic Operation in Projector 
Mode
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Note
• If you move the projector or Interactive 

Panaboard, the position of the computer 
screen projected onto the Interactive 
Panaboard screen will be moved. This will 
result in out of position of the Electronic Pen. 
If this happens, you will need to calibrate the 
unit again by executing Calibrate in the pop-
up menu from the Toolbar.

• In the Projector mode, use the Electronic 
Pen with its cap on.

•Do not cover the position receiver with your 
hand as this may cause interactive function 
to stop functioning.

•Press down firmly with the point of the 
Electronic Pen on the screen film until you 
hear a buzzing sound.

•For precise positioning, keep the Electronic 
Pen perpendicularly to the Interactive 
Panaboard screen during use. Inclined pen 
angle will cause the shift of position.

• If double-click does not work properly, 
confirm that the same position is accurately 
clicked twice. When the position is different, 
it is not recognized a double-click. Or, try 
different timing of depressing and releasing 
of the Electronic Pen. This operation is also 
depending on the setting of the double-click 
speed in “Mouse” of the Windows “Control 
Panel”.
8

Step 2:Drawing and erasing lines 
on the Desktop

1 Click either  (Black, Red, Blue or Green 
Marker) in the Desktop Drawing Tool to draw 
handwritten lines.

•The shape of the mouse cursor changes to 
.

2 Position the mouse pointer where you want to 
draw a handwritten line on the Desktop and 
drag the Mouse.

3 Click  (Eraser) in the Desktop Drawing 
Tool to erase the handwritten line.

•The shape of the mouse cursor changes to 
.

4 Drag the Mouse to the area on the Desktop to 
be erased.

Note
•The width and color of the markers and the 

size of the eraser can be changed. (See 
page 41.)

•To disappear the Desktop Drawing Tool, 
select a marker  or eraser  and press 
the projected screen with the Electronic Pen 
while pressing the pen button. 
To display the Desktop Drawing Tool again, 
locate the Electronic Pen at the desired 
place on the projected screen and press the 
projected screen with the Electronic Pen 
while pressing the pen button. 

•The Desktop (projected image) can be 
printed by pressing the  (Copy Key) on 
the Interactive Panaboard.
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Step 3:Recording image and lines 
data on the Desktop

Data of lines drawn or erased on the Desktop using 
the Desktop Drawing Tool can be recorded in 
Interactive Panaboard format files (extension “.ipb”, 
referred to as IPB documents).
There are two methods to record drawings. To select 
the recording method, refer to “Setting Options” on 
page 36.

The following is (Method 2) Record strokes and 
background image together. For more details on 
recording methods, refer to “Recording Drawing Data 
in IPB Document” on page 47.

1 Draw lines with markers  and  eraser.

2 Click  (REC Start) in the Desktop Drawing 
Tool.

•The image to be recorded will be displayed in 
a window.

3 Click [Record] or [Record & Erase 
drawings] to record the drawings.

•Clicking [Record] will record the drawings 
and leave them.

•Clicking [Record & Erase drawings] will 
record the drawings and erase them.

•Clicking [Cancel] will cancel recording.

4 Click  (REC Stop) in the Desktop Drawing 
Tool.

•The Save As window appears.

5 Enter the name of the folder where you want 
to save the file.

•The extension of the file is “.ipb”.

6 Click [Save].

Note
•Do not change the Desktop resolution while 

recording data. If changed, the Desktop 
image will not be displayed properly when it 
is displayed in the View window.

•To record more than one page, refer to 
“Recording Drawing Data in IPB Document” 
on page 47.
Step 4:Displaying the recorded 
data with View window

Desktop background data and drawings stored using 
the Desktop Drawing Tool can be displayed in the 
View window as well as browsed, played back and 
edited.

1 If the View window is not displayed, right-click 
the icon  in the Taskbar and click Tool - 
View Window to display the View window.

2 Click Open... in the File menu.

•The Open window appears.

3 Enter the folder to look in and the file name 
you want to open.

•The file has an “.ipb” extension.

4 Click [Open].

Note:
•Many different operations can be executed in 

the displayed IPB document.
- Saving the IPB document in another file 

format. (See page 57.)
- Switching a page of the IPB document. 

(See page 61.)
- Editing a page of the IPB document. (See 

page 61.)
- Playing back the IPB document. (See page 

63.)
- Recognizing Handwriting in the IPB 

document. (See page 64.)
- Printing the IPB document. (See page 66.)
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The Desktop Drawing Tool is a tool for 
drawing, erasing, recording, etc. on the 
Desktop.
Right-click the icon  in the Taskbar 
and click Tool - Draw in the pop-up 
menu. The Desktop Drawing Tool will 
appear and check mark is placed next 
to the Draw menu. Clicking Draw again 
will delete the check mark and 
disappear the Desktop Drawing Tool.
The Desktop Drawing Tool is always 
displayed at the front of the Desktop. 
From this Desktop Drawing Tool, the 
tools can be selected for drawing or 
erasing lines.
The data drawn on the Desktop can be 
stored into the IPB document together 
with the desktop image. They can be 
displayed or edited by the View window.
Desktop Drawing Tool consists of the 
following tools.

Using the Desktop Drawing 
Tool

Tool Description
 Arrow Uses the Electronic Pen as 

the mouse
Black 
Marker

By dragging the mouse, black 
line can be drawn.

Red Marker By dragging the mouse, red 
line can be drawn.

Blue Marker By dragging the mouse, blue 
line can be drawn.

Green 
Marker

By dragging the mouse, green 
line can be drawn.

Eraser By dragging the mouse, lines 
can be erased.

Undo Restores the drawing lines 
line by line.

Redo Cancels the undo.

Setting Changes the width, color of 
the markers and size of the 
eraser.

All Clear Clears all drawn lines.

Capture Takes the Desktop image as 
an image file.

Print Prints out the Desktop image.
0

On-Screen 
Keyboard

(Handwriting 
Tablet)

Displays the On-Screen 
Keyboard / Handwriting Tablet 
or clears its display.

PowerPoint 
Slide Show

Plays or quits the PowerPoint 
Slide Show.

Next Performs the same operation 
as “Next” in a PowerPoint 
Slide Show.

Previous Performs the same operation 
as “Previous” in a PowerPoint 
Slide Show.

White 
Background

Changes the background of 
the Desktop to the whiteboard. 
Clicking once again will 
release the Whiteboard status.

Refresh All of the drawn lines on the 
Desktop are refreshed.

REC Start Recording of drawings is 
started or the first page is 
recorded depending on the 
recording method. 

REC Stop Stops recording and stores the 
recording data.

Page No. Displays the page number 
which is being recorded.
The initial number is (0). 
When the  (REC Start) 
icon is clicked, it is changed to 
(1), and following pages will 
be numbered accordingly.

New Page
or
REC Page

Saves the current page and 
starts recording process for 
the next page.
or
Records the second or 
subsequent page.

Shrinking Shrinks the Desktop Drawing 
Tool.

Expansion Expands the Desktop Drawing 
Tool.

Tool Description
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Note
•When the Desktop Drawing Tool is closed, 

the drawings are erased.

• (Next) and  (Previous) are only 
displayed when the PowerPoint Slide Show 
is running.

■ Drawing or Erasing Lines

For the instructions, refer to “Step 2: Drawing and 
erasing lines on the Desktop” on page 38.

Note
•The width, color of the markers and the size 

of the eraser can be changed. (See page 41.)
•Handwritten lines drawn on the Desktop may 

be hidden or shifted when an application or a 
window is operated. If this occurs, click 

 (Refresh) to display the Desktop.

■ Refreshing Drawings on the 
Desktop

Drawings on the Desktop may be hidden or shifted 
when an application or a window is operated. If this 
occurs, refresh the Desktop.

1 Click  (Refresh) in the Desktop Drawing 
Tool.

■ Erasing All Drawings on the 
Desktop

1 Click  (All Clear) in the Desktop Drawing 
Tool.

•A verification window appears.

2 Click [OK] to clear all.
■ Changing Marker / Eraser 
Settings

It enables to change the width, color of the markers 
and the size of the eraser used in the Desktop 
Drawing Tool. These settings are effective until being 
changed.

1 Click  (Setting) in the Desktop Drawing 
Tool.

•The Marker / Eraser Setting window 
appears.

2 Change the width or color of markers, or size 
of the eraser.

•Same Width:
Width of all color markers can be set to the 
same width of the black marker by checking 
the check box.

•Black / Red / Blue / Green:
Width (1 - 30 dots) or color of each marker 
can be set.

To change the width,
- Type the number of width.
- Click the right or left arrow of the scroll bar.
- Drag the scroll bar to the right or left.
To change the color,
Click the color of marker. Click the desired 
color from the Basic colors palette in the 
Color window.
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•Highlight:
The line becomes transparency by clicking it 
so the background can be seen.

•Eraser Radius:
The size of the eraser can be set from 1 to 
60 dots. 

To change the size,
- Type the number of size.
- Click the right or left arrow of the scroll bar.
- Drag the scroll bar to the right or left.

3 Click [OK].

•A window appears to confirm whether the 
setting is also reflected to the lines that have 
been already drawn. 

4 Click [All Strokes] or [New Strokes].

•All Strokes:
All lines are redrawn with the new setting.

•New Strokes:
The setting is only reflected for subsequently 
drawn lines.

Note
•When the marker color is changed, the color 

will be displayed on the bottom-right of the 
marker tool in the Desktop Drawing Tool, but 
the marker tool color will not change.

• If the background is dark and the drawn lines 
are hard to see when marker is highlighted, 
remove the check mark of the Highlight 
check box. When the line crosses with one of 
the different color, the cross point will 
become dark.
2

■ Changing the Desktop to the 
Whiteboard

Allows you to make the background of the Desktop 
white.

1 Click  (White Background) in the Desktop 
Drawing Tool.

•Clicking  (White Background) again 
returns the background to the original. 

■ Saving Desktop as an Image File

Allows you to save the background image of the 
Desktop and handwritten lines that were drawn on the 
Desktop as an image file.
There are two ways to save files; saving a file after 
entering the file name or automatically saving a file 
with the saving date as its file name. For more details 
on file saving methods and settings for file format, 
refer to “Setting Options” on page 36.

[A] Saving files by entering file names

1 Click  (Capture) in the Desktop Drawing 
Tool.

•The Save As window appears.

2 Enter the folder where you want to save the 
file, the file name and the file type.

•The following file formats can be selected for 
the File type.
Bitmap Files (*.bmp), TIFF Files (*.tif) or 
JPEG Files (*.jpg)

3 Click [Save].

• In the Save As window, if an existing TIFF 
file is selected, another window will be 
displayed to confirm overwriting it or adding 
the file to it. Selecting “Yes” will add the 
image to the end of the existing file as a 
multi-page TIFF. Selecting “No” will delete 
the existing image and save as a single page 
TIFF file.
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[B] Saving files automatically, named with 
the date

If the Save file automatically, named with date is 
enabled in the Options setting, files will be 
automatically saved. (Refer to “Setting Options” on 
page 36.)

1 Click  (Capture) in the Desktop Drawing 
Tool.

•The save verification window appears.

2 Click [OK].

• If Do not show this message again check 
box is clicked, the save verification window 
does not appear when saving a file. To 
display it again, refer to “Setting Options” on 
page 36.

■ Printing an Image of the Desktop

Allows you to print the background image of the 
Desktop and handwritten lines that were drawn on the 
Desktop.

1 Click  (Print) in the Desktop Drawing Tool.

•The Print window appears.

2 Set the Printer and Number of copies.

3 Click [OK].

•The Printing window appears.
•To stop the printing, click [Cancel] in the 

Printing window.
■ Using the On-Screen Keyboard

On-Screen Keyboard is a tool which the user can use 
to input data: it is a virtual keyboard on the computer 
screen which has been projected onto the Interactive 
Panaboard screen. It can also be used with the 
handwriting tablet to recognize handwriting text.
The On-Screen Keyboard provided with Windows can 
also be used instead of the original keyboard.
(Refer to “Setting Options” on page 36.)

[A] Inputting characters

1 Click  (On-Screen Keyboard (Handwriting 
Tablet)) in the Desktop Drawing Tool.

• If the Handwriting Tablet appears, click  
icon on the Handwriting Tablet to change to 
the On-Screen Keyboard. Selecting 
Standard Keyboard or Enhanced 
Keyboard from the Keyboard menu of the 
Handwriting Tablet is also available to 
change to the On-Screen Keyboard.

2 Activate the target application window for 
input. Align the text cursor with the input field.

3 Click the characters on the On-Screen 
Keyboard.

•The title of the target application for input 
currently is displayed as the On-Screen 
Keyboard title.

[B] Using the Handwriting Tablet

1 Click  (On-Screen Keyboard (Handwriting 
Tablet)) in the Desktop Drawing Tool.

• If the On-Screen Keyboard appears, click 
 icon on the On-Screen Keyboard to 

change to the Handwriting Tablet. Selecting 
Handwriting Tablet from the Keyboard 
menu of the On-Screen Keyboard is also 
available to change to the Handwriting 
Tablet.

2 Activate the target application window for 
input. Align the text cursor with the input field.
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3 Draw text in the Handwriting Tablet using the 
Electronic Pen.

•The handwriting will be recognized and 
displayed on the upper-left of the 
Handwriting Tablet.

4 Click [send] of the Handwriting Tablet.
•The recognized text is entered into the 

application.
•The recognized text can be cleared by 

clicking [clear] before clicking [send].

Note
•English or German handwriting is the only 

language that can be recognized. 
Handwriting recognition for German will be 
available only when German is selected in 
“Regional Setting” of the Windows “Control 
Panel”.

•Words that are possibly misspelled will be 
displayed with wavy underlining. To Correct 
words that might be misspelled, right-click on 
the word and select from the list of 
alternatives. However, in some cases, no 
alternatives will be displayed.

• It is possible to enter the text directly into the 
target application even if [send] is not 
clicked. This setting can be performed by 
selecting Handwriting Tablet from the 
Settings menu. (Refer to “[G] Setting the 
Handwriting Tablet” on page 45.) However, 
spell check cannot be used in this case.
4

[C] Selecting the style

1 On the Keyboard menu, select one of the 
following.

•Enhanced Keyboard: 
A keyboard with a numeric keypad appears.

•Standard Keyboard: 
A keyboard without a numeric keypad 
appears.

•Handwriting Tablet: 
Displays the entry tablet for handwriting 
recognition.

Standard Keyboard

[D] Selecting the layout

1 On the Keyboard menu, select one of the 
following.

•101 keyboard: 
The U.S. standard keyboard appears.

•102 keyboard: 
The general-purpose keyboard appears.

Note
• If the data which has actually been input 

does not match the characters displayed on 
the On-Screen Keyboard, ensure that the 
input locale settings match. The input locale 
can be set using “Input Locale” in ”Keyboard” 
of the Windows “Control Panel”.

[E] Always displaying the keyboard at the 
top of the screen

1 Click Always On Top on the Settings menu, 
and place a check mark next to the menu.

• If the On-Screen Keyboard is not to be 
displayed continuously kept at the top of the 
screen, click Always On Top on the 
Settings menu to remove the check mark.
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[F] Changing the keyboard size

1 Click the desired On-Screen Keyboard size 
from Resize in the Settings menu.

Note
•Alternatively, the size of the On-Screen 

Keyboard can be changed by dragging one 
of the edges of the On-Screen Keyboard 
window.

•The aspect ratio of the On-Screen Keyboard 
is fixed.

•The width of the window size ranges from 
one-half to double the Middle size.

•The keyboard size in Standard Keyboard 
mode or Enhanced Keyboard mode cannot 
be changed by dragging the upper or lower 
borders.

•The tablet size in Handwriting Tablet mode 
cannot be changed by dragging the upper 
border.

[G] Setting the Handwriting Tablet

1 Click Handwriting Tablet... in the Settings 
menu.

•The Handwriting Tablet Settings window 
appears.

2 The following items can be set.

•Waiting Time to Recognition: 
Sets the standby time after handwritten input 
until recognition is started.

•Add Space: 
Specifies whether or not to add a space after 
the recognized text.

•Send Recognition Directly: 
Checking the check mark directly send the 
recognized text to the target application even 
if [send] is not clicked in the On-Screen 
Keyboard window.

3 Click [OK].
■ Controlling a PowerPoint Slide 
Show

A PowerPoint Slide Show can be run using the 
Desktop Drawing Tool. Drawing data is recorded for 
each slide, so the drawing data will always be 
displayed for the corresponding slide. Drawing data 
can be saved in a file, which enables reuse with the 
next time presentation.

To use the PowerPoint Slide Show features, 
PowerPoint® 97 or later must be installed on the 
computer.
The drawing data for slides is used by the Desktop 
Drawing Tool. It is not PowerPoint data.

[A] Running a slide show

1 Click  (PowerPoint Slide Show) in the 
Desktop Drawing Tool.

•The Open window appears.

2 Enter the file path and file name of the 
PowerPoint file that runs the Slide Show.

•The file name extension is “.ppt”.

3 Click [Open].

•PowerPoint will be launched and the Slide 
Show will automatically run.

Note
•Clicking  (PowerPoint Slide Show) when 

the PowerPoint file is open will automatically 
run the Slide Show of the open file without 
displaying the Open window. This will be the 
Slide Show controlled.

•To control a Slide Show that PowerPoint is 
running, click  (PowerPoint Slide Show).
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[B] Switching slides in the slide show

The Desktop Drawing Tool displays  (Next) and 
 (Previous) buttons when a Slide Show is running.

1 Click  (Next) or  (Previous) in the 
Desktop Drawing Tool.

•There is no need to momentarily change to 
 (Arrow) to switch slides when selecting 

the Marker or Eraser tool.
•These perform the same operation as “Next” 

and “Previous” in a PowerPoint Slide Show.

Note
•The drawing data will not be displayed when 

switching slides without using the Desktop 
Drawing Tool. In this case, click  
(Refresh) to display the drawing data.

[C] Quitting the slide show

1 Click  (PowerPoint Slide Show) in the 
Desktop Drawing Tool when the Slide Show is 
running.

•The PowerPoint Slide Show will be stopped.

Note
• If the Slide Show is reached the end by 

clicking  (Next), the Desktop Drawing 
Tool will automatically sense the end of the 
Slide Show and stop without clicking  
(PowerPoint Slide Show).
6

■ Saving the Drawing Data for 
Slides

When the Desktop Drawing Tool is exited, the 
confirmation window will be displayed whether to save 
the data drawn with markers or eraser. If the drawing 
data is saved through this window, it will be named 
with the same name as the PowerPoint file (with the 
file extension “.ips”). By default, it will be saved to the 
same folder as the PowerPoint file. If the file cannot 
be saved to this folder, it will be saved to the folder set 
in “Options”. (Refer to “Setting Options” on page 36.)

Note
•The drawing data is saved in a proprietary 

format as a drawing data file with the file 
extension “.ips”.

■ Using the Saved Drawings with 
Slides

When (PowerPoint Slide Show) is clicked, if there 
is a drawing data file in the same folder with the 
PowerPoint file or in the folder specified in “Options” 
with the same name as the PowerPoint file (refer to 
“Setting Options” on page 36), a window will be 
displayed to confirm whether to use the file. If the file 
is chosen for use, the data will be loaded and 
displayed with the slides.

Note
• If a drawing data file that was saved is no 

longer needed, delete it using Windows 
Explorer or a similar means.
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■ Recording Drawing Data in IPB 
Document

Allows you to create an IPB document to record the 
drawing on the Interactive Panaboard.
There are two ways to record. To select it, refer to 
“Setting Options” on page 36.

[A] Recording by using “(Method 1) Draw 
strokes and record after verifying the 
background image”

1 Click  (REC Start) in the Desktop Drawing 
Tool.

•The image of the Desktop will be displayed in 
a window.

2 Click [OK] to store the data as the background 
image of the 1st page.

• If there are drawn lines on the desktop, a 
verification window appears to confirm 
whether to erase drawings.
To erase the drawn lines, click [Yes].
To leave the drawn lines, click [No].

3 Draw lines using  (Black, Red, Blue or 
Green Marker) or  (Eraser) in the Desktop 
Drawing Tool.

4 Click  (New Page) to add a page.
If no pages will be added, advance to step 11.

•The recording image will be displayed in a 
window.

5 Click [OK] to record the recording image.

•A verification window appears to confirm 
whether to erase the drawings.

6 Click [Yes] to erase the drawings.
Or, click [No] to leave the drawings.

•The recording process is paused. The 
mouse cursor will automatically change to 

 (Arrow), allowing the background image 
to be changed. While the recording process 
is paused, all of the Desktop Drawing Tool 
icons are inactive except  (REC Start) 
and  (White Background) icons.

7 Switch the Desktop to the desired 
background.
8 Click  (REC Start) to restart the recording 
of a new page.

•The image of the Desktop will be displayed in 
a window.

9 Click [OK] to store the data as the background 
image of a new page.

•All of the Desktop Drawing Tool icons will 
become active.

10 To add multiple pages, repeat steps 3 to 9.

11 Click  (REC Stop) in the Desktop Drawing 
Tool.

•The recording image will be displayed in a 
window.

12 Click [OK] to record the recording image.

•The Save As window appears.

13 Enter the folder where you want to save the 
file and the file name.

•The extension of the file is “.ipb”.

14 Click [Save].

[B] Recording by using “(Method 2) 
Record strokes and background 
image together”

1 Switch the Desktop to the desired 
background. Draw lines using  (Black, 
Red, Blue or Green Marker) or  (Eraser) in 
the Desktop Drawing Tool.

2 Click  (REC Start) in the Desktop Drawing 
Tool.

•The image to be recorded for the current 
page will be displayed in a window.

3 To record, click [Record] or [Record & Erase 
drawings].

•Clicking [Record] will record the drawings 
and leave it.

•Clicking [Record & Erase drawings] will 
record the drawings and erase it.

•Clicking [Cancel] will cancel recording.

4 It is needed to add multiple pages, draw lines 
and click  (REC Page) instead of  
(REC Start), then click [Record] or [Record & 
Erase drawings].
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5 Click  (REC Stop) in the Desktop Drawing 
Tool.

•The Save As window appears.

6 Enter the folder where you want to save the 
file and the file name.

•The extension of the file is “.ipb”.

7 Click [Save].

Note
•Do not change the Desktop resolution while 

recording data using method 1 or method 2. 
If changed, the Desktop image will not be 
displayed properly in the View window.

•While using method 1 to record data, page 
numbers can be verified by  (Page No.) 
in the Desktop Drawing Tool. Before starting 
to record data, the data value is “0” and will 
change to “1” when  (REC Start) is 
clicked. The value will then count up for each 
page break. When switching the computer 
screen being projected onto the screen of 
the Interactive Panaboard during a meeting, 
begin drawing after adding  (New Page) 
and recording the background image of the 
new page.

•While using method 2 to record data, the 
number of pages can be verified by  
(Page No.) in the Desktop Drawing Tool. 
Before starting to record data, the data value 
is “0” and it will change to “1” when  
(REC Start) is clicked. The value will then 
count up each time the  (REC Page) is 
clicked.

•A maximum of 50 pages can be stored.
8

■ Switching the Desktop Drawing 
Tool Display

The Desktop Drawing Tool can be displayed in three 
sizes.

• Standard Display:
Shows all buttons.

• Marker Display:
Shows only the buttons used for drawing and 
erasing handwritten lines. The buttons for saving 
image files or recording IPB documents are not 
showed.

• Compact Display:
Use the Compact Display when the Desktop 
Drawing Tool covers up too much of the image 
behind it. It keeps the part that is hidden to a 
minimum.

Switching among their views can be done by clicking 
the  (Shrinking) or  (Expansion) buttons.

Note
•Tools cannot be changed in the Compact 

Display view.
•During PowerPoint Slide Show, the 

Standard Display and Marker Display 
views show  (Next) and  (Previous) 
icons.

•To disappear the Desktop Drawing Tool, 
select a marker  or eraser  and press 
the projected screen with the Electronic Pen 
while pressing the pen button. 
To display the Desktop Drawing Tool again, 
locate the Electronic Pen at the desired 
place on the projected screen and press the 
projected screen with the Electronic Pen 
while pressing the pen button. 

Standard Display Marker Display

Compact Display
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1 Turn on the Interactive Panaboard.

2 Turn on your computer and start up Windows.

3 For Windows 2000 / Windows XP
Connect the USB cable provided from the 
electronic board to the computer.
•The Interactive Panaboard Software is 

automatically started.
For WIndows 98 / Windows Me
Click [Start] and select Programs - 
Panasonic - Interactive Panaboard - 
Interactive Panaboard.
•The window appears to show the Interactive 

Panaboard is detected.

Note
• If the Panaboard Operation Panel is 

displayed using the Panasonic-DMS, the 
Panasonic Interactive Software cannot be 
started. Close the Panaboard Operation 
Panel and start it. Refer to page 72.

•To change the setting so the Interactive 
Panaboard Software is not started 
automatically when connecting the USB 
cable, perfrom the following.

(1) Connect the USB cable provided from the 
electronic board to the computer.

(2) Click [Start] and select Settings - 
Control Panel, then double-click 
Scanners and Cameras icon. 
(For Windows XP, click [start] and select 
Control Panel)

(3) Double-click Panaboard-UB8 USB 
Device Driver icon and click the Disable 
device events check box in the Events 
tab. Click [OK].

To start the Interactive Panaboard Software, 
click [Start] and select Programs - 
Panasonic - Interactive Panaboard - 
Interactive Panaboard.
(For Windows® XP, All Programs instead of 
Programs)

4 Click [OK].

•The Select Mode window appears.

Using the Panaboard in 
Whiteboard Mode

Starting the Interactive 
Panaboard Software
5 Click the Whiteboard icon and click [OK].
•The Whiteboard Window appears and the 

icon  is registered in the Taskbar.

Note
• If the Interactive Panaboard is not detected, 

the notification window appears. In this case, 
check the status of the Interactive 
Panaboard and confirm that the USB cable is 
connected. For details on the settings of the 
communications port, refer to “Setting the 
Communication Port” on page 35.

• If the Interactive Panaboard Software is used 
without connecting the Interactive 
Panaboard, click [Offline] in the notification 
window. In the off-line state, a file recorded in 
the Whiteboard mode can be played back 
and edited.

•The tool tip text displayed when the mouse is 
located over the icon  in the Taskbar 
allows you to determine the current mode.
- Whiteboard mode: “Interactive Panaboard 

(Whiteboard)”
- Projector mode: “Interactive Panaboard 

(Projector)”

■ Exiting the Interactive Panaboard 
Software

Right-click the icon  in the Taskbar and click Exit 
in the pop-up menu.

Right-click the icon  in the Taskbar to display the 
pop-up menu.
Following operations are possible in the pop-up menu.

Select Mode...: (see page 35)
Allows you to switch between modes 
(Projector mode / Whiteboard mode).

Open / Close Whiteboard Window:
Allows you to open or close the Whiteboard 
window by selecting this menu. This menu is 
alternately changed to open or close every 
selecting.

Settings:
Communication Port...: (see page 35)
Sets the communication port.
Adjustment...: (see page 36)
Adjusts the position of the Electronic Pen or 
the Electronic Eraser to improve the shifted 
position.
Options...: (see page 36)

Pop-up Menu Configuration
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Print out image automatically rotates to fit 
printer paper direction setting is only related 
to the Whiteboard mode.

Help Topics...:
Displays the help of the Interactive Panaboard 
Software.

About...:
Displays the Interactive Panaboard Software 
version information.

Exit:
Exits the Interactive Panaboard Software.

This section explains the basic operations when using 
the Interactive Panaboard Software in the Whiteboard 
mode. We recommend trying the operations in 
accordance with the following steps to help you 
completely understand the operations in the 
Whiteboard mode.

Step 1:Drawing and erasing handwritten 
lines on the Interactive 
Panaboard screen

To start the Interactive Panaboard Software, see page 49.

1 If the Whiteboard window is not displayed, 
right-click the icon  in the Taskbar and 
click Open Whiteboard Window.

2 Remove the cap of the Electronic Pen and 
draw on the Interactive Panaboard screen 
using the Electronic Pen.

•The position on the screen where you are 
drawing will be reproduced on the page in 
the Whiteboard window on the computer in 
real-time.

Basic Operation in 
Whiteboard Mode
0

3 Erase handwritten lines drawn on the 
Interactive Panaboard screen using the 
Electronic Eraser.

•Portions erased on the screen will also be 
erased on the page in the Whiteboard 
window.

•These drawing and erasing operations are 
recorded automatically.

Note
•The following shows the writing area in the 

Whiteboard mode. Do not write the shaded 
area on the figure.

•Do not cover the position receiver with your 
hand as this may cause interactive function 
to stop functioning.

•Press down firmly with the point of the 
Electronic Pen or the eraser on the screen 
film until you hear a buzzing sound.

•Do not perform the following action near 
(less than 1m) the Interactive Panaboard 
while using the Whiteboard mode as this 
may display unnecessary streaks not written 
in the Whiteboard window.
- Exchanging markers for interactive (small) 

of the Electronic Pen
- Setting or removing a marker cap of the 

Electronic Pen
- Pushing the point of the Electronic Pen

•When exchanging markers for interactive 
(small) of the Electronic Pen, lock the pen 
holder lever while fully inserting the marker 
into the pen holder until you hear a buzzing 
sound. Detection of the marker color may not 
work well unless the marker is inserted fully 
into the pen holder. (Refer to “Setting the 
Electronic Pen” on page 25.)

25 mm (1")

35 mm
(1 3/8")

35 mm
(1 3/8")

50 mm (2")100 mm
(3 15/16")

Writing areaWriting area

Position receiver
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Step 2:Adding a new page by 
pressing the Advance Key

Add New Page when Advance Key is pressed is 
selected in the Options window, a new page is added 
to an IPB document when the  (Advance Key) on 
the Interactive Panaboard is pressed. This method is 
recommended in the case the screen is fed every time 
one topic is finished in only one side of the screen.

1 Click Options... in the Settings menu.

•The Options window appears.

2 Enable Add New Page when Advance Key 
is pressed. (This is the default setting.)

3 Click [OK].

4 Draw lines and press  (Advance Key) on 
the Interactive Panaboard.

•The screen is fed and a new page is 
automatically added as the last page of the 
IPB document.

5 Wipe the drawings clearly if something had 
been drawn on the screen.

6 Repeat steps 4 – 5 if needed.

Note:
•New pages can be added until the total 

pages are reached to 50 pages.
•The screen can be printed by pressing the 

 (Copy Key) on the Interactive 
Panaboard.
Step 3:Switching the page by 
pressing the Advance Key 

Switch the current page in last 2 pages when 
Advance Key is pressed is selected in the Options 
window, the screen is fed and the corresponding page 
is selected in the IPB document every pressing the 

 (Advance Key). This method is recommended in 
the case a conference is continued using both 
screens while changing the screen (front and back).

For the detailed information, refer to “[G] Options 
setting” on page 70.

1 Click Options... in the Settings menu.

•The Options window appears.

2 Enable Switch the current page in last 2 
pages when Advance Key is pressed.

•The copy function of the Interactive 
Panaboard is changed to copy (backup) the 
editing page of the IPB document.

3 Click [OK].

•A new page is added and total page of the 
IPB document becomes 2 pages.

• If the saved IPB document more than 2 
pages is opened, the previous one of the last 
page is selected.

4 Draw lines and press  (Copy Key) on the 
Interactive Panaboard to copy (backup) the 
selected page.

•The copied page is added to the left of the 
last 2 pages in the IPB document.
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5 Press  (Advance Key) on the Interactive 
Panaboard.

•The screen is fed and the last page of the 
IPB document is selected.

6 Draw lines and press  (Advance Key) on 
the Interactive Panaboard to return to the 
other side screen if needed.

•The screen is fed and the previous one of the 
last page of the IPB document is selected.

7 Continue the conference while changing the 
screen by pressing  (Advance Key).

Step 4:Saving the drawing data in a 
file

All drawing and erasing operations in the Whiteboard 
window are automatically recorded. And if the data is 
saved in the Interactive Panaboard format file 
(extension “.ipb”, referred to as IPB documents), the 
details of meetings with the Panaboard can be played 
back and edited later.

1 Click Save As... in the File menu.

•The Save As window appears.

2 Enter the folder where you want to save the 
file and the file name.

•The extension of the file is “.ipb”.

3 Click [Save].
2

Step 5:Opening the saved data

The saved data can be displayed in the Whiteboard 
window as well as browsed, played back and edited.

If the Whiteboard window is not displayed, right-click 
the icon  in the Taskbar and click Open 
Whiteboard Window.

1 Click Open... in the File menu.

•The Open window appears.

2 Enter the folder to look in and the file name 
you want to open.

•The file has an “.ipb” extension.

3 Click [Open].

Note
•Many different operations can be executed in 

the displayed IPB document.
- Saving the IPB document in another file 

format. (See page 57.)
- Switching a page of the IPB document. 

(See page 61.)
- Editing a page of the IPB document. (See 

page 61.)
- Playing back the IPB document. (See page 

63.)
- Recognizing Handwriting in the IPB 

document. (See page 64.)
- Printing the IPB document. (See page 66.)
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■ View Window in Projector Mode

Desktop background data and data of handwritten 
lines recorded using the Desktop Drawing Tool can be 
displayed in the View window as well as browsed, 
reproduced and edited.

In the View window, displaying and editing IPB 
documents which are recorded by the Desktop 
Drawing Tool are possible. It can also be used for 
handwriting recognition for output as text.

To display the View window, see page 39.

■ Whiteboard Window in 
Whiteboard Mode

Whiteboard window is a function to reproduce the 
lines drawn using the Electronic Pen and the 
Electronic Eraser on the Interactive Panaboard to the 
computer screen.
Recorded image data can be saved as an IPB 
document so that you can see the file later. 

The following functions are available; 
- Adds lines with marker. 
- Erases unnecessary lines with eraser. 
- Copies entire page or partial image to other general 

image formats such as Bitmap, JPEG, TIFF and 
these images can be transferred to other application 
software. 

- Provides handwriting recognition for output as text.

To open the Whiteboard window, see page 49.

Using the View Window 
or Whiteboard Window 

About View Window / 
Whiteboard Window
■ View Window / Whiteboard 
Window

1. Title bar: 
Indicates the currently opened file name of the 
IPB document.

2. Toolbar: 
Toolbar has buttons which most frequently 
used functions are formed as icon.
It consists of Main Toolbar, Page / Play 
Toolbar and Marker / Eraser Toolbar. Each 
tool bar can be moved to any location by 
dragging.

3. Main view: 
The selected thumbnail page is displayed in 
the Main view by clicking the thumbnail. You 
can draw, erase lines or copy a part of page 
on the IPB document.

4. Thumbnail view: 
The thumbnail image of all pages of the IPB 
document can be displayed.
At the bottom of each thumbnail, the last 
modified date is displayed.
The thumbnail corresponding to the main view 
is framed.

5. Status bar: 
Indicates the information of the IPB document.
Replay mode: 
Indicates if it is in the replaying or not.
Image size: 
Indicates the page size when it is 100% 
display ratio.
Page number: 
Indicates the total number of pages and the 
page being displayed.

6. Text Editor: 
Receives the data handwriting that has been 
recognized. Enables editing of the text.

1

6

5

4

3

2
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■ Difference between the View 
Window and the Whiteboard 
Window

The View window (Projector mode) and the 
Whiteboard window (Whiteboard mode) are windows 
which function to display and edit IPB documents. 
Basically, they both have identical functions. However, 
the Whiteboard window has some functions the View 
window does not have as follows.
For more detailed information, refer to “Managing IPB 
Documents” on page 57.

System of units:
• The View window displays IPB documents which 

record the drawing on the Interactive Panaboard 
screen projecting the computer screen. 
Consequently, the size is represented by dots.

• In the Whiteboard window the drawing on the 
Interactive Panaboard screen using the Electronic 
Pen and Electronic Eraser is virtually displayed in a 
computer window. Consequently, units of length are 
standard. You can choose between units in 
millimeters or inches.

New in the File menu:
• The View window is used to display and edit IPB 

documents created by the Desktop Drawing Tool. 
Consequently, the New menu does not exist.

• Closes the IPB document currently displayed in the 
Whiteboard window and displays a new IPB 
document.

Add New Page in the Edit menu:
• The View window is used to display and edit IPB 

documents created by the Desktop Drawing Tool. 
Consequently, the Add New Page menu does not 
exist.

• Adds a new page (blank page) next to the last page 
of the IPB document in the Whiteboard window.

Add Copy Page in the Edit menu:
• The View window is used to display and edit IPB 

documents created by the Desktop Drawing Tool. 
Consequently, the Add Copy Page menu does not 
exist.

• Adds a copy of the page next to the last page of the 
IPB document in the Whiteboard window.
4

■ Menu Configuration

Following menus can be used in the View window or 
the Whiteboard window.

* denotes the function of Whiteboard window only.

Menu Description
[File] menu

New * Closes the IPB document 
and creates a new IPB 
document.
 (See page 57.)

Open Opens an IPB document. 
(See page 57.)

Save Saves the IPB document. 
(See page 57.)

Save As Saves the IPB document with 
new file name. (See page 
57.)

Print Preview Enables to check the layout 
before printing. 
(See page 66.)

Print Prints the IPB document. 
(See page 66.)

Export (See page 57.)
Image Outputs the page as the 

image file (Bitmap, JPEG, 
TIFF). 

HTML Outputs the page as the 
HTML file. 

Close View 
window

Closes the View window. 
(View window only)

Close 
Whiteboard 
window *

Closes the Whiteboard 
window. 

[Edit] menu
Undo Restores drawing backward 

line by line. (See page 62.)
Redo Cancels the undo. 

(See page 62.)
Copy Copies the selected area in

the page to the clipboard.
(See page 62.)

Select All Selects entire page. (See 
page 62.)

Add New Page * Adds a new page next to the 
last page. (See page 62.)
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Add Copy Page * Adds copied page next to the 
last page. (See page 62.)

Delete Current 
Page

Deletes the displayed page. 
(See page 62.)

Handwriting 
Recognition

Converts handwriting letters 
to texts. (See page 64.)

[Edit] menu (When editing using the Text Editor)
Undo Restores the state before the 

last text action. 
(See page 64.)

Redo Cancel the undo. 
(See page 64.)

Cut Removes the selected text 
and copies it to the clipboard. 
(See page 65.)

Copy Copies the selected text to 
the clipboard. (See page 65.)

Copy All Pages Copies the text of all pages to 
the clipboard. (See page 65.)

Paste Applies the text in the 
clipboard. (See page 65.) 

Delete Deletes the selected text. 
(See page 65.)

Select All Selects all the text of a page. 
(See page 65.)

[Page / Play] menu
Start Starts the replay. 

(See page 63.)
Pause Pauses the replay. 

(See page 63.)
Stop Stops the replay. 

(See page 63.)
Playback Option (See page 67.)

All Pages Plays back all pages. 
Selected Page Plays back selected page.
Loop Playback Plays back continuously.

Go to First Page Displays the first page. 
(See page 61.)

Go to Previous 
Page

Displays the previous page. 
(See page 61.)

Go to Next Page Displays the next page. 
(See page 61.)

Go to Last Page Displays the last page. 
(See page 61.)

Go to Page Displays the specified page. 
(See page 61.)

Menu Description

[View] menu

Zoom (See page 60.)
Fit Window Displays the current page to 

fit window. (See page 60.)
200% Displays the current page by 

200% of its original size.
150% Displays the current page by 

150% of its original size.
100% Displays the current page by 

100% of its original size.
75% Displays the current page by 

75% of its original size.
50% Displays the current page by 

50% of its original size.
25% Displays the current page by 

25% of its original size.
10% Displays the current page by 

10% of its original size.
Full Screen Uses the entire display area 

of your monitor to display the 
current page. (See page 60.)

Main Toolbar Displays or closes the Main 
Toolbar. (See page 56.)

Page / Play Displays or closes the Page / 
Play Toolbar. (See page 56.)

Markers / Eraser Displays or closes the 
Markers / Eraser Toolbar. 
(See page 56.)

Status Bar Displays or closes the Status 
Bar.

Text Editor Displays or closes the Text 
Editor.

[Settings] menu
Information Stores the information of the 

meeting. (See page 66.)
Play Changes the setting of 

playback. (See page 67.)
Markers and 
Eraser

Changes the color and size 
of the marker, and size of the 
eraser. (See page 67.)

Export Image Sets the quality of JPEG or 
compression of TIFF etc. 
(See page 68.)

Menu Description
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File Changes the default folder to 
save an IPB document or 
interval timing when 
performing the automatic 
back up. (See page 69.)

Spell Check Sets the setting for 
spellcheck of the Text Editor. 
(See page 70.)

Options Sets the length unit mm or 
inch and the display method 
of a file name in the title bar. 
(See page 70.)

[Help] menu
Help Topics Displays the help 

information.
About Displays the version of the 

Interactive Panaboard 
Software.

Menu Description
6

■ Tool Bars

Following menus can be used in View window or 
Whiteboard window.

• Main Toolbar

* There is only the  (New icon) in the Whiteboard 
window.

• Page / Play Toolbar

• Markers / Eraser Toolbar

To display a Toolbar, click the View menu and then 
click the Toolbar you want to display (any one of Main, 
Page / Play, Markers / Eraser).
If the Toolbar is already displayed, there is a check 
mark next to that Toolbar.

To turn off the Toolbar, click View menu and remove 
the check mark from the Toolbar you want to hide.

Note
•The Toolbars can be dragged and moved to 

any location on the screen.

Fit Window

Full Screen

Handwriting Recognition

Zoom
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■ Creating an IPB Document 
(Whiteboard window only)

In Whiteboard mode, creating a new IPB document is 
needed to record work performed on the Interactive 
Panaboard.

1 Click New in the File menu.

•When the IPB document currently being 
edited is changed, a window will display 
asking you to confirm the save.

Note
•When the Whiteboard window is displayed, 

an IPB document is automatically created 
and a new page is displayed in the main 
view.

■ Opening an IPB Document

1 Click Open... in the File menu.

•The Open window appears.

2 Enter the folder to look in and the file name 
you want to open.

•The file has an “.ipb” extension.

3 Click [Open].

Managing IPB Documents
 Note
•To open a recently opened file, click the file 

name you want to open in the File menu. 
Eight recently opened IPB documents will be 
displayed in the File menu.

•The IPB documents can also be opened by 
double-clicking the file icon in the file system.
View window or Whiteboard window is 
automatically switched depending on the file 
created in Projector or Whiteboard mode.

• If it is needed to create an automatic save file 
for when a power failure or other incident 
occurs, check the Create Recovery File 
check box in the File Settings window 
(Settings - File...) in advance.
When opening the recovery file, select All 
Files in the Files of type box to display the 
recovery file with an “.ip~” extension.

■ Saving the IPB document

1 Click Save in the File menu.

Note
•To save a currently open IPB document with 

a different name, click Save As... in the File 
menu.

■ Saving the IPB Document in 
another File Format

Exporting images allows you to save files in another 
file format to use it in other applications. This makes it 
possible to easily distribute the contents of meetings 
stored in the IPB document to users who do not have 
the Interactive Panaboard Software.

An IPB document can be saved as an image file or 
HTML file as follows.
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[A] Saving as an image file

1 Click Image... of Export in the File menu.

•The Export Image window appears.

2 Specify the pages to be exported and image 
size.

•To save all the pages, select All # Pages.
(#: total number of pages)

•To specify the page range, click Pages and 
then enter the page range.

•Clicking [Setup...] will allow you to set image 
size, JPEG file quality and TIFF file 
compression.

3 Click [OK].

•The Save As window appears.

4 Enter the folder where you want to save the 
file, the file name and the file type.

•The following file formats can be selected for 
the Save as type. 
Bitmap Files (*.bmp), JPEG Files (*.jpg) or 
TIFF Files (*.tif)

•When specifying TIFF to save multiple 
pages, Multiple Page or Single Page can 
be selected.
8

5 Click [Save].

Note
• If Single Page is selected when saving 

multiple pages as TIFF files, the number of 
files created will correspond to the number of 
pages. A two-digit extension will be added 
after the file name (such as “01”, “02”, “03”, 
etc.) to match the page number.

•When saving as a multi-page TIFF file, if an 
existing TIFF file is selected, another window 
will be displayed to confirm overwriting it or 
adding the file to it. Selecting “Yes” will add 
the image to the end of the existing file as a 
multi-page TIFF. Selecting “No” will delete 
the existing image and save as a multi-page 
TIFF file.

•When saving a single page with an existing 
TIFF file name, another window will be 
displayed to confirm overwriting it or adding 
the file to it. Selecting “Yes” will add the 
image to the end of the existing file as a 
multi-page TIFF. Selecting “No” will delete 
the existing image and save as a single-page 
TIFF file.

•Settings such as size and compression when 
saving the IPB document as an image file 
are managed in Export Image... in the 
Settings menu. (Refer to “[D] Setting an 
image file when exporting or copying by 
dragging and dropping” on page 68.)
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[B] Saving as an HTML file

You can save the IPB document as an HTML file per 
page.
In addition, meeting information can also be output at 
the same time to that index page.
Setting multiple pages and saving the IPB document 
as an HTML file will create an index file, linked HTML 
pages and images.
Using this method will allow the contents of meetings 
recorded in the IPB documents to easily provide to 
people using a Web browser.

1 Click HTML... of Export in the File menu.

•The Export HTML window appears.

2 Click [Browse...] and specify the folder where 
the IPB document will be saved as a HTML 
file.

3 Set the page range.

•Selecting All Pages will output all the pages 
of the displayed IPB document to the HTML 
files.

•Selecting Current Page will output only the 
page displayed in the main view to the HTML 
file.

•Selecting Pages will output the specified 
page or the specified page range to the 
HTML file. Enter a comma to separate the 
page numbers or a hyphen to connect the 
first page number and the last page number.
4 If necessary, change the other export settings 
shown below and click [OK].

[File] group

•Page Image: 
Changes the width and height of the image 
of the exported page in pixel. Checking the 
Constrain Proportions check box will 
preserve the ratio of the width and height of 
the page even if the dimensions of the 
exported page are changed.

•Thumbnail Image:
Changes the width and height of the 
thumbnail image of the exported page in 
pixel. Checking the Constrain Proportions 
check box will preserve the ratio of the width 
and height of the page even if the 
dimensions of the exported page are 
changed.

[Colors] group

Clicking the rectangular colored portion will 
display the Color window. Click the color from 
the Basic colors.

•Background:
Selects the color of the background of the 
HTML file.

•Text: 
Selects the color of the text used in the 
HTML file.

•Table Labels: 
Selects the background color of the labels of 
the tables in the HTML file.

•Table Items: 
Selects the background color of the items of 
the tables in the HTML file. 

[Export Contents] group

The following is added to the index page of the 
exported HTML file by checking each check 
box.

•Thumbnail Image: 
Adds a thumbnail image of the page.

•Page Date: 
Displays the date and time the page was 
created.

•Created Date: 
Displays the date and time the IPB document 
was created.

•Modified Date: 
Displays the date and time updated last to 
the IPB document.
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•Participants / Manager / Subject / 
Description / Contacts / Company: 
Displays the information specified in the 
Information... in the Settings menu.

Note
• It is recommend to save HTML files in an 

empty folder where another HTML files are 
not stored. If you attempt to save a file in an 
already existing folder, a message will be 
displayed asking you to confirm whether or 
not to overwrite the already existing HTML 
file.

•When exporting multiple pages to HTML 
files, an index file “index.html” and HTML 
files named after the page numbers (for 
example, n pages) “page 01.html, page 
02.html, page 03.html, --- page 0n.html” are 
created. Images displayed in the HTML files 
named after the page numbers “page 01.jpg, 
page 02.jpg, page 03.jpg, --- page 0n.jpg” 
are also created. If the Thumbnail Image 
check box is checked, thumbnail images 
displayed in the HTML files named after the 
page numbers “small 01.jpg, small 02.jpg, 
small 03.jpg, --- small 0n.jpg” are also 
created.
0

■ Changing the Display Method

[A] Displaying expanded / reduced page

You can expand the page and display a portion of the 
page larger or reduce the page and display the entire 
page.

1 Position the cursor over Zoom in the View 
menu and click the percentage (%) you want 
to display.

Note
•You can also enter a numeric value into 

Zoom box in the Main Toolbar to change the 
display percentage. The percentage can be 
set in units of 1%.

[B] Displaying entire page inside the main 
view

1 Click Fit Window of the Zoom in the View 
menu.

[C] Displaying page as large as possible

To display the page on the screen as large as 
possible, switch to full screen display mode.
In this mode the Toolbar is displayed as a free toolbar.

1 Click Full Screen in the View menu.

•To exit full screen display mode and return to 
the original display mode, right-click the 
mouse and click Full Screen in the pop-up 
menu.

Note
•To hide the Toolbar in full screen display, 

right-click the mouse and click the Toolbar 
you want to hide in the pop-up menu and 
remove the check mark. In addition, to 
display the Toolbar, click the Toolbar you 
want to display in the pop-up menu to place 
the check mark.
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■ Switching a Page of the IPB 
Document

[A] Displaying first page

1 Click Go to First Page in the Page / Play 
menu.

[B] Displaying previous page

1 Click Go to Previous Page in the Page / Play 
menu.

[C] Displaying next page

1 Click Go to Next Page in the Page / Play 
menu.

[D] Displaying last page

1 Click Go to Last Page in the Page / Play 
menu.

[E] Specifying a page number to display

1 Click Go to Page... in the Page / Play menu.

•The Go to Page window appears.

2 Enter the page number you want to display in 
Go to Page.

3 Click [OK].

Note
•To quickly display a page, click the thumbnail 

display of the page you want to display in 
thumbnail view.
■ Editing a page of the IPB 
document

You can edit pages displayed in the main view in the 
View window or Whiteboard windows as follows.

• You can use the marker or eraser for additions and 
modifications.

• You can add a page. (Whiteboard window only)
• You can delete a page.
• You can select portions or entire page and save the 

contents in the clipboard or copy to other 
applications.

[A] Drawing and erasing lines on a page

1 Display the page where you want to draw or 
erase handwritten lines in main view.

2 To draw handwritten lines, click either  
(Black Marker, Red Marker, Blue Marker or 
Green Marker) in the Markers / Eraser 
Toolbar.

•The shape of the mouse cursor changes to 
.

3 Position the mouse where you want to draw a 
handwritten line on the page and drag the 
mouse.

4 To erase handwritten lines, click  (Eraser) 
in the Markers / Eraser Toolbar.

•The shape of the mouse cursor changes to 
.

5 Drag the mouse to the area on the page you 
want to erase.

Note
•To return to the state before the changes, 

click Undo in the Edit menu.
•The width and color of the markers and the 

size of the eraser can be changed. (See 
page 67.)
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[B] Undoing

You can restore the drawing using the marker or 
eraser to their original state, stroke by stroke.

1 Click Undo in the Edit menu.

•To return to the previous state, click Undo 
again.

Note
•To cancel the operation that was undone, 

click Redo in the Edit menu.
•The Undo / Redo can be used over and 

over. However, if the page changes, the 
Undo / Redo will be reset.

[C] Adding a new page to the IPB 
document (Whiteboard window only)

In Whiteboard mode, a new page can be added next 
to the last page of the IPB document.
When advancing the screen of the Interactive 
Panaboard during a meeting, add a new page.

1 Click Add New Page in the Edit menu.

•A new page will be added next to the last 
page of the IPB document and the display is 
switched to that page.

Note
•A maximum of 50 pages can be recorded. 

[D] Adding the Copied page to the IPB 
document (Whiteboard window only)

In the Whiteboard mode, the copy of the page 
currently displayed in main view can be added next to 
the last page of the IPB document.
Use this to leave the current contents on the screen 
before adding new changes.

1 Click Add Copy Page in the Edit menu.

•The copy of the currently displayed page will 
be added next to the last page of the IPB 
document and the display is switched to that 
page.

•A maximum of 50 pages can be recorded. 
2

[E] Deleting currently displayed page

1 Display the page you want to delete in the 
main view.

2 Click Delete Current Page in the Edit menu.

•A window will be displayed asking you to 
confirm the delete.

3 Click [OK] to delete.

•Use caution because deleted pages cannot 
be recovered to their original state by Undo 
in the Edit menu.

[F] Copying selected page range to 
clipboard

1 Click  (Arrow) in the Markers / Eraser 
Toolbar and drag the mouse to select the 
portion of the page you want to copy. 

•To select the entire page, click Select All in 
the Edit menu.

•The selected area will be displayed in 
reverse.

2 Click Copy in the Edit menu.

Note
•To cancel the selection, click outside of the 

selected area.
•The Image copied to the clipboard can be 

pasted in other applications.
•The Image copied to the clipboard becomes 

BMP image.
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[G] Copying selected page range to other 
application

You can copy data to other applications by dragging 
and dropping the selected page area. To perform this 
operation, the application copied to must support OLE 
(Object Linking and Embedding).

1 Open the file where the data will be copied to 
and adjust the position of the application 
window such that the page to be copied and 
the file to be copied are displayed in the 
screen. 

2 Click  (Arrow) in the Markers / Eraser 
Toolbar and drag the mouse to select the 
portion of the page you want to copy.

•To select the entire page, click Select All in 
the Edit menu.

•The selected area will be displayed in 
reverse.

3 Drag the selected area to the copy destination 
of the other application.

Note
•To cancel the selection, click outside of the 

selected area.
•The file formats to be dragged and dropped 

can be set by Export Image... in the 
Settings menu.
■ Playing back the IPB document

The operations of drawing and erasing lines on each 
page are automatically recorded in stroke units and 
the drawing can be played back and confirmed later.

1 Click All Pages or Selected Page of the 
Playback Option in the Page / Play menu.

•The check mark is placed next to the 
activated menu.

2 Click  (Start) in the Page / Play Toolbar.

• In the case of All Pages playback, the 
playback will start from the original state of 
the first page. In the case of Selected Page 
playback, the displayed page contents will 
return to their original state and the playback 
will start.

•To stop the playback in the middle, click  
(Pause) in the Page / Play Toolbar. To 
restart the playback in the middle, click  
(Start) in the Page / Play Toolbar.

•While stopping temporarily, you can move 
the Play Scroll bar in the Page / Play 
Toolbar to playback manually.

•To end the playback in the middle, click  
(Stop) in the Page / Play Toolbar.

•Playback is completed when the Play Scroll 
bar reaches the far right end and stops.

Note
•You can click the arrows at the right and left 

of the Play Scroll bar or drag the Play Scroll 
bar to the right or left to playback the 
drawing.

•While playing back, you cannot use the 
marker and eraser in the Markers / Eraser 
Toolbar. In addition, in Whiteboard mode 
drawing on the screen of the Interactive 
Panaboard will not be reproduced either.

•You can change the playback conditions 
such as the playback interval, playback page 
and the playback loop. (See page 67.) You 
can also change the settings of the playback 
page and the playback loop from Playback 
Option in the Page / Play menu.

Play Scroll bar
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■ Recognizing Handwriting in the 
IPB document

[A] Recognizing Handwriting

1 Click  icon or Handwriting Recognition... 
in the Edit menu.

•The Handwriting Recognition window 
appears.

2 Select the Recognition Range and click [OK].

•The recognition results will be output as text 
to the Text Editor.

•Current Page:
Drawing in the selected page is converted to 
text.

•All Pages:
Drawings in all pages are converted to texts. 
The recognition result of the selected page 
can be displayed in the Text Editor by 
selecting the page.

Note
• If Delete the existing text check box is 

checked, the existing text will be deleted 
before the recognition results are output.

•English or German handwriting is the only 
language that can be recognized. 
Handwriting recognition for German will be 
available only when German is selected in 
“Regional Setting” of the Windows “Control 
Panel”.

•To specify a text for recognition using the 
mouse, click  (Arrow) in the Markers/
Eraser Toolbar, drag so the rectangle 
encloses around the drawing for recognition 
in the Main view, and click the Handwriting 
Recognition... menu.

•When the text cursor is aligned with the 
recognized text, the original drawing will be 
indicated with dotted lines.
4

•The recognized text can be selected by 
clicking the dotted line of the original drawing 
with  (Arrow) in the Markers/Eraser 
Toolbar.

•Cutting or deleting the recognized text 
dissociates it from the handwritten lines.

•When All Pages are recognized, selecting 
Undo from the Edit menu cannot restore the 
file to the previous state.

[B] Replacing Possibly Misspelled Words 
with Alternatives

1 Click inside the Text Editor window.

2 Right-click on a word that might be 
misspelled.

•A pop-up menu will display alternatives.

3 Select the alternative word from the menu.

•The text will be replaced with the menu 
selection.

Note
•To specify displaying possibly misspelled 

words, click Spell Check... in the Settings 
menu. (See page 70.)

•A maximum of five alternatives will be 
displayed.

•No alternatives will be displayed in the pop-
up menu when there are no alternatives.

•Alternatives will only displayed for text 
recognized using the handwriting recognition 
function.

[C] Undoing Actions

1 Click inside the Text Editor window.

2 Click Undo in the Edit menu.

Note
•To cancel the Undo, click Redo in the Edit 

menu.
•Undo / Redo can be performed up to 100 

times, but the counter is reset if another page 
is selected.
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[D] Copying Text

1 Click inside the Text Editor window.

2 Select the target text by dragging it.

3 Click Copy in the Edit menu.

•The text will be copied to the clipboard.
•Selected text can be removed and copied to 

the clipboard by clicking Cut in the Edit 
menu.

Note
•Text copied to the clipboard can be pasted 

into other applications.

[E] Copying text from All Pages to the 
clipboard

1 Click inside the Text Editor window.

2 Click Copy All Pages in the Edit menu.

•The text in all pages will be copied to the 
clipboard.

Note
•Text copied to the clipboard can be pasted 

into other applications.

[F] Pasting text

1 Click inside the Text Editor window.

2 Move the text cursor to the point of insertion.

3 Click Paste in the Edit menu.

•The clipboard text will be inserted to the point 
of insertion.
[G] Deleting text

1 Click inside the Text Editor window.

2 Select the target text by dragging it.

3 Click Delete in the Edit menu.

•The text will be deleted.

Note
•When recognized text is deleted, the relation 

between the original drawing and the 
recognized text is cancelled. (See page 64.)

[H] Selecting all text on a page

1 Click inside the Text Editor window.

2 Click Select All in the Edit menu.

•All text in the current page will be selected.

Note
•To cancel the selection, click inside the Text 

Editor window.
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■ Print the IPB document

[A] Confirming print image of the IPB 
document before printing

1 Click Print Preview in the File menu.

•The window is switched to the Print Preview 
screen.

2 Click [Close] to exit the Print Preview and 
return the display mode to the original state.

Note
•The screen image printed is called the Print 

Preview. In the Print Preview you can display 
print images of multiple page at a time. You 
can also expand or reduce the size of the 
page displayed in the screen.

[B] Printing currently displayed IPB 
document

1 Click Print... in the File menu.

•The Print window appears.

2 Set the Printer, Print range and Number of 
copies.

3 Click [OK].

•The Printing window appears.
•To stop the printing, click [Cancel] in the 

Printing window.
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■ Settings

[A] Setting the meeting information

Allows you to record the meeting information of the 
IPB document; titles, subjects and descriptions, etc.
The information can be output with page images when 
exporting the IPB documents to HTML files.

1 Click Information... in the Settings menu.

•The Information window appears.

2 Enter necessary information as follows, and 
then click [OK].

•Summary 
Enter a summary of the recorded meeting 
here.

- Title / Participants / Company / Manager / 
Subject / Description:
Enter each item of the meeting.

- Created On: 
Automatically displays the date and time 
the IPB document was created.

- Modified On: 
Automatically displays the date and time 
the IPB document was updated finally.

•Contact 
Enter information to contact individuals for 
questions concerning the meeting here.

- Name: 
Enter the names of the person in charge of 
the meeting.

- e-mail: 
Enter the e-mail address of the person in 
charge of the meeting.

- Home page: 
Enter the home page of the person in 
charge of the meeting.
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[B] Setting conditions when playing back 
the IPB document

1 Click Play... in the Settings menu.

•The Playback Setting window appears.

2 Enter an interval for playing back the stroke in 
the Interval time between strokes.

•You can click the arrows at the right and left 
of the scroll bar or drag the scroll bar to the 
right or left to set a desired interval.

•Selected Page:
Without check mark:
The first page through the last page are 
played back.
With check mark:
Only currently selected page is played back. 

•Loop Playback:
Without check mark:
Page(s) is played back once depending on 
the Selected Page setting.
With check mark:
Page(s) is played back repeatedly 
depending on the Selected Page setting.

Note
•The playback interval can be set in a range 

of 0 - 2 seconds in 1 msec (millisecond = 1 / 
1000 second) units.

•The Selected Page and Loop Playback 
settings can be also changed from Playback 
Option in the Page / Play menu.
[C] Setting the marker width, color or the 
eraser size

Change the width and color of the markers and the 
size of the eraser used in the View window or the 
Whiteboard window. The marker width and color can 
be changed for four marker colors.

1 Click Markers and Eraser... in the Settings 
menu.

•The Marker / Eraser Setting window 
appears.

2 Change the width or color of markers, or width 
of the eraser.

•Same Width:
Width of all color markers can be set to the 
same width of the black marker by checking 
the check box.

•Black / Red / Blue / Green:
Width [1 - 30 dots (View window) / 0.1 - 25.4 
mm (Whiteboard window)] or color of each 
marker can be set.
To change the width,
- Type the number of width.
- Click the right or left arrow of the scroll bar.
- Drag the scroll bar to the right or left.
To change the color,
Click the color of marker. Click the desired 
color from the Basic color palette in the Color 
window.

•Highlight:
The line becomes transparency by clicking it 
so the background can be seen.
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•Eraser Radius:
The size of the eraser can be set from 1 to 
60 dots (View window) or 0.1 - 50.8 mm 
(Whiteboard window). 
To change the size,
- Type the number of size.
- Click the right or left arrow of the scroll bar.
- Drag the scroll bar to the right or left.

3 Click [OK].

•A window will appear where you can select 
whether or not to apply the new settings to 
handwritten lines drawn up to now.

4 Click [All Strokes] or [New Strokes].

•Clicking [Yes] will redraw the lines drawn up 
to that point using the new settings. Clicking 
[No] will only reflect the new settings for any 
subsequently drawn lines.

Note
•The unit of the marker width and the eraser 

size is dots in the View window and 
millimeters or inches in the Whiteboard 
window.

•When the marker color is changed, the color 
will be displayed on the bottom-right of the 
Desktop Drawing Tool marker icon, but the 
marker tool color will not change.

• If the background is dark and the drawn lines 
are hard to see when marker is highlighted, 
remove the check mark of the Highlight 
check box. When the line crosses with one of 
the different color, the cross point will 
become dark.

•These settings are effective until being 
changed.

[D] Setting an image file when exporting 
or copying by dragging and dropping

It allows you to set the size when exporting a page to 
an image file and the file format to create when 
copying data to other applications by dragging and 
dropping a selected page area.

1 Click Export Image... in the Settings menu.

•The Export Image Settings window appears.
8

2 Specify the export image setting.

• [Export Image Files] group
- Image Size: 

To change the size when saving a page as 
an image file, enter a desired width and 
height. Check the Constrain Proportions 
check box when setting the aspect ratio of 
the page to an identical value.

- JPEG: 
To set the quality level when exporting a 
page as a JPEG format image file. The 
larger number will get higher quality for the 
image file than small number when 
exporting. However, the file size will be 
large.

- TIFF: 
To perform compression when exporting a 
page as a TIFF format image file, check the 
Compression (PACKBITS) check box.

• [Drag and Drop Files] group
Sets the file format to create when copying 
data to other applications by dragging and 
dropping a selected page area.

The following file formats can be selected.
Windows BMP (*.bmp), JPEG (*.jpg) or TIFF 
(*.tif)
- If JPEG is selected, you can enter a quality 

level in Quality.
- If TIFF is selected, you can compress an 

image file by checking the Compression 
(PACKBITS) check box.
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3 Click [OK].

Note
•The default of the width is 800 dots and the 

Constrain Proportions check box is 
checked. The height will be different 
depending on the size of the Panaboard 
screen and the screen resolution of the 
computer where the projector is projecting 
the image.
[E] Setting a work folder and the recovery 
file

Allows you to set the default folder when saving an 
IPB document.
If it is set to automatically create a recovery file, 
previously saved IPB documents can be recovered 
when a power failure or other incident occurs.

1 Click File... in the Settings menu.

•The File Settings window appears.

2 Specify the file folder setting.

•Save Default Folder: 
Sets the path of the folder you want to 
display as a default when saving a new IPB 
document.

•Create Recovery File: 
To create a recovery file, check the check 
box.

- Recovery File Folder: 
To save the recovery file at the same folder 
as the original file, check the Same folder 
as original file check box. Otherwise, set 
the directory to save the recovery file. 

- Save automatically every # minutes: 
To automatically save the recovery file, 
enter an interval time within a range of 1 - 
120 minutes.

3 Click [OK].
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[F] Spell check setting for recognized 
handwriting

Set the spell check for recognized handwriting.

1 Click Spell Check... in the Settings menu.

•The Spell Check Setting window appears.

2 Specify the spell check setting.

•When checking the check box, possibly 
misspelled words are displayed with wavy 
underlining.

3 Click [OK].

Note
•Only texts that is recognized using the 

handwriting recognition function can be 
checked the spelling.
0

[G] Options setting

Allows you to set the display method of the file name 
in the Title bar, the display unit system and the Control 
Panel key setting of the Interactive Panaboard in 
Whiteboard mode.

1 Click Options... in the Settings menu.

•The Options window appears.

2 Specify the option setting.

•Display full path in Title bar: 
To display the full path of the currently 
opened file in the title bar of the View window 
or the Whiteboard window, check the check 
box.

•Measurement: 
Selects the length unit of the Whiteboard 
window.

•Add New Page when Advance Key is 
pressed:
A new page is added to the IPB document in 
Whiteboard mode when the  (Advance 
Key) on the Interactive Panaboard is 
pressed.

•Switch the current page in last 2 pages 
when Advance Key is pressed:
The screen is fed and the corresponding 
page is selected in the IPB document in 
Whiteboard mode every pressing the  
(Advance Key) on the Interactive Panaboard. 
It enables to copy (backup) the selected 
page of the IPB document by pressing the 

 (Copy Key) on the Interactive 
Panaboard.
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- Make the current page empty after copy 
page is added:
With check mark (default setting):
The selected page of the IPB document is 
copied and the selecting page is 
automatically erased as a new page (blank 
page) by pressing the  (Copy Key). 
When selecting this option, be sure to wipe 
to clear the Interactive Panaboard screen 
after pressing the  (Copy Key).
Without check mark:
The selected page of the IPB document is 
copied by pressing the  (Copy Key) 
and the page is left as is.

- Do not output copy page from 
Panaboard printer when Copy Key is 
pressed.:
With check mark:
The selected page of the IPB document is 
not printed when the  (Copy Key) is 
pressed.
Without check mark (default setting):
The selected page of the IPB document is 
printed when the  (Copy Key) is 
pressed.

•No response:
An IPB document it not influenced even if the 

 (Advance Key) on the Interactive 
Panaboard is pressed.

3 Click [OK].

Note
•The computer screen will be projected onto 

the screen of the Interactive Panaboard in 
Projector mode and because there is no 
physical size, the display unit system is only 
in pixels (dots) and cannot be changed.

•The length unit millimeter or inch is used as 
unit to represent the page size on the status 
bar, pen width and eraser size.
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You can scan images on the screen to your computer 
by operating Panasonic-DMS.

1 Click [Start], move the pointer to Programs–
Panasonic–Panasonic Document 
Management System–Document Manager.
(For Windows XP, All Programs instead of 
Programs.)
•The Panasonic-DMS software runs.

2 Click the File menu, then click Select 
Source....

3 Select Panaboard UB-8 USB TWAIN Driver 
and click [Select].

4 Click the File menu, then click Acquire 
Image..., or click the  (scanner) icon on the 
Toolbar.

•The Panaboard Operation Panel appears.

Note
• If the Panasonic Interactive Software is 

started, the Panaboard Operation Panel 
cannot be displayed. Close the Panasonic 
Interactive Software and start it.

•When the Panaboard Operation Panel is not 
displayed, check the USB cable connection 
or the condition of the electronic board.

Using the Panasonic-DMS

Scanning
2

5 Click the  (Scan) button or the 
(2-Screen Scan) button.

•Scanning starts and the scanned image will 
be displayed on the screen of the computer. 
It is also possible to start scanning using the 

 (Copy Key) or  (2-Screen Copy 
Key) on the electronic board.

6 Click [Close] on the Panaboard Operation 
Panel to finish scanning.

•About the Document Manager, refer to the 
Document Management System operating 
instructions in the CD-ROM.

Note
• Dragging the Panaboard Operation Panel using 

the mouse or activating other software programs 
during scanning may cause scanning troubles.



Using the Panasonic-DMS

U
sing
It is possible to perform the same operations as with the electronic board control panel (page 16) from the following 
Panaboard Operation buttons.

Note
•While the Panaboard Operation Panel is displayed, the  (Copy Key) and  (2-Screen Copy Key) on 

the electronic board control panel are used for scanning images into the computer.

Panaboard Operation Panel

Panel Name Description

Contrast/
Remaining Film 
Indicator

This lamp indicator notifies the user when the time to replace the 
thermal transfer film is approaching (estimated) and of the contrast used 
during scanning or copying.
Indicator off: Normal scanning or copying contrast
Indicator on: Darker than normal scanning or copying contrast
Indicator flashing*: Almost time to replace the thermal transfer film

(Note that only about 15 more sheets may be 
copied when this indicator starts flashing.)
Replacement film (UG-6001) is separately 
available from the dealer where you purchased 
your unit.

* The flashing indicator will go out after the power is turned off, or 
the printer has been opened and closed. (When copying is per-
formed, this indicator will begin flashing again.)

Contrast Button Each time this button is pressed, the unit will alternate between normal 
and dark contrast modes (Normal/Dark).

2-Screen Scan 
Button

This button scans the front and back of the screen on a single page.

Multi-Copy/
Error Indicator

This indicator displays the number of copies to be made. The display 
changes each time the Multi-Copy/Stop Button is pressed.

Example: 1 →  2 →  ··· →  9 →  1 →  ···
When an error occurs, a flashing symbol will appear in this display to 
indicate the error status. (See page 80.)

Multi-Copy/Stop 
Button

When making multiple copies, press this button until the desired number 
of copies is displayed on the Multi-Copy/Error Indicator. This button can 
also be pressed to stop copying while executing multiple copies.
• The display changes as shown below each time the screen is copied. 

After reaching 0, the display will reset to 1.
Example: 5 →  4 →  3 →  2 →  1 →  0 →  1 

(Number is counted down.)
* If scanning, the setting 1 to 9 for the number of copies is ignored.

Scan Button This button scans the screen.

Advance Button Clicking this button advances the screen from right to left.

2-Screen Copy 
Button

This button causes the front and back of the screen to be copied on a 
single sheet of paper.
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To print documents from the computer to the printer, select the Print menu of the application software and select the 
printer name set when installing.

The standard printer name is “Panaboard-UB8 USB Printer (A4/Letter *)”.
* A4 or Letter changes with the models.

Note
• The Multi-Copy/Error Indicator flashes when printing.

After printing, all the panel keys are disabled until the Multi-Copy/Error Indicator lights.
• You cannot stop printing after printing starts. Do not attempt to stop printing.
• Do not turn off the power of the electronic board or unplug the USB cable before printing finishes. It may cause 

the computer operation to become unstable.
• A maximum 9 copies are available.
• The output port can hold up to 10 sheets of copied paper. (Note that exceeding the output port’s capacity may 

result in paper jams.)
• The Contrast Key is not effective for adjusting the contrast of print.
• When printing almost black pages continuously uniform color density and light line streaks may appear. In such 

a case, try again after waiting a while.
• When the unit falls in abnormal condition during printing, printing jobs (jobs in the spooler) may be lost. In such 

a case, print again.

Copy Button This button causes the screen to be copied.

Status Box

The status box displays the status of the TWAIN driver and the 
electronic board.

Stand by: The electronic board is stand by.
Both of the Panaboard Operation Panel and the electronic 
board control panel are operational.

Rotating: The electronic board is rotating the screen.
Copying: The electronic board is copying the screen.
Scanning: The electronic board is now scanning the images on the 

screen.
Converting: Indicates that the image data is being converted so that the 

computer will be able to display the scanned data.
Busy: The electronic board is processing jobs.
Error: An error has occurred with the electronic board.

About Button Click to display information about the TWAIN driver.

Close Button Click to close the Panaboard Operation Panel.

Printing

Panel Name Description
4



Daily Care and Maintenance

7

H
elp
H
elp
Always turn off the power switch and unplug the 
power plug when cleaning outside and inside the 
unit.

Gently wipe the screen film and unit with a water-
dampened cloth that has been thoroughly wrung.

Note
•Use a commercially available white board 

cleaner for hard-to-erase stains. 
(SANFORD® EXPO® white board cleaner 
etc.)
If you accidentally write on the screen with an 
oil-based marker, wipe with a small amount of 
ethyl alcohol.

•Do not use thinner, benzine or cleaners 
containing abrasives as this may result in 
discoloration.

•Do not wipe the screen film with a dry cloth as 
this may generate a static charge.

Daily Care and 
Maintenance

Cleaning the Screen and the Unit
When the erasing surface of the eraser becomes dirty, 
hold down the sheet under the top sheet with your 
finger and peel off the dirty sheet (white or gray sheet) 
by pulling in the direction of the arrow.

Note
•Be sure to peel off only one sheet; white or 

gray sheet of the eraser.
•When the eraser becomes thin, make sure 

that the corners of the eraser do not strike the 
screen during erasing as this may damage 
the screen.

If black streaks appear on the copy, clean the printer 
head and the platen roller.
If paper jams occur frequently, clean the pick-up roller.

1 Push down the printer open lever and open the 
printer door.

Caring for the Eraser

Cleaning the Printer Head, 
Platen Roller and Pick-up 
Roller

White or gray 
sheet

Printer door
5



Daily Care and Maintenance

7

2
Dampen the tip of a cotton-tipped swab in ethyl 
alcohol and gently wipe the printer head.

Note
•Never touch the printer head or the 

surrounding area with your hands as this may 
disable copying.

3
Remove the thermal transfer film with both 
hands and carefully wipe any dirt or stains off 
the platen roller and pick-up roller.

•For details on removing the thermal transfer 
film, see page 22.

•Dampen a soft cloth with neutral kitchen 
cleaner diluted in water, wring the cloth 
thoroughly, and wipe the entire surface of the 
rollers while rotating them. If this does not 
remove all dirt, wipe with a cloth dampened 
with ethyl alcohol.

Clean the Printer Head  

Cotton-tipped swab

Printer head
(Gold)

Clean the Platen Roller and the 
Pick-up Roller 

Pick-up roller
Platen roller
6

4 Install the thermal transfer film in its original 
position and close the printer door.

•For details on installing the thermal transfer 
film, see pages 18.

•Close the printer door firmly until a click is 
heard.

Note
• If “ ” is still flashing after closing the printer 

door, make sure that the thermal transfer film 
has been installed properly and tightened.

•The printer door should be closed to make 
copies properly. Confirm both latches are 
locked.

Latches



Daily Care and Maintenance

H
elp
As the lifetime of the batteries in the Electronic Pen or 
the Electronic Eraser comes near to the end, the 
message “Low Battery” appears on the computer 
screen to which the electronic board is connected 
using interactive functions. When this message 
appears, get new batteries ready and replace the old 
ones as soon as possible.
When replacing batteries, remove the old batteries and 
replace according to step 1 under “Setting the 
Electronic Pen” on page 25 in the case of the 
Electronic Pen or according to “Setting the Electronic 
Eraser” on page 26 in the case of the Electronic 
Eraser. Continued use of low batteries may result in a 
shifting of position or malfunction.

If the cloth of the Electronic Eraser becomes dirty with 
erased markings, replace with a new eraser cloth 
according to “Replacing the Eraser Cloth” on page 26.

Replacing the Batteries in the 
Electronic Pen and the 
Electronic Eraser

Replacing the Cloth of the 
Electronic Eraser

Após o uso as pilhas / baterias 
contidas neste produto poderão 
ser dispostas em lixo doméstico.

For Brasil

For Taiwan ( 台灣 )
77



Troubleshooting
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Treat problems according to the information given in the table below. If problems still persist, call your dealer for 
service.

Troubleshooting

Symptom Care and Remedy See
Page

Power switch is on but the 
indicator is off.

Check that the power plug is securely plugged in.
(If the indicator still does not light, turn the power off and on again.) –

Copied copy paper will not come 
out.

The unit is out of copy paper or thermal transfer film. (The Error 
Indicator flashes “ ” or “ ”.)

Insert copy paper or replace the thermal transfer film.

19
22

The printer door is open. (The Error Indicator flashes “ ”.)
Close the printer door firmly until a click is heard. 19

The paper cover is open.
Close the paper cover firmly until a click is heard. 20

Paper is jammed in the printer. (The Error Indicator flashes “ ”.)
Open the printer door and remove the jammed paper. 23

The platen roller and pick-up roller are dirty.
Open the printer door and wipe the platen roller and the pick-
up roller to clean them.

75

Nothing is printed on the paper or 
copies are faint or blurred.

The markers for interactive (small) are used.
Use the markers (big). –

The writing on the screen is too thin or light.
Make thicker, darker lines or change to a new marker. –

The printer door is slightly open.
Close the printer door firmly until a click is heard. 19

Black streaks or blank (unprinted) 
spots appear on the copy (copy 
paper is dirty).

The printer head or platen roller is dirty.
Open the printer door and clean any dirt off the printer head 
and platen roller.

75

The thermal transfer film is wrinkled because it was set in place 
without removing excess slack.

Rewind the used portion of the thermal transfer film to remove 
the excess slack, then reattach it.

18

A black or white horizontal line 
appears, or the page prints in 
black or blank.

The unit is in strong sunlight or strong lighting.
Change the direction of the screen or block the light. –

The screen does not advance 
when the Copy, Advance or 
Reverse Key is pressed.

Static electricity was generated when the screen film was wiped.
Turn off the power and slowly move the screen by hand. –

Contrast/Remaining
Film Indicator flashes.

The time to replace the thermal transfer film is approaching. (Only 
about 15 more sheets may be copied.)

Prepare a new replacement film (UG-6001).
22

When connecting a USB cable 
after installing the driver, the 
warning message is displayed to 
require the Panaboard UB-8 
Driver Disk.

The necessary file is not found in Windows 98.
Click the location’s box and select the pass 
“UB-8\UsbDrv\Win98-Me” in the pull down menu.

–

8



Troubleshooting

H
elp
The software installed before is 
deleted from the Programs menu 
or cannot be used after installing 
the Panasonic-DMS.

After the existing Panasonic-DMS software is uninstalled, the new 
Panasonic-DMS is installed.

Install the new Panasonic-DMS again as follows.
1. Uninstall the current Panasonic-DMS.
2. Install the old Panasonic-DMS.
3. Install the new Panasonic-DMS in the same folder with the 

old one.

30-31

Panasonic Document 
Management System menu is 
remained in the Programs menu 
even if Panasonic-DMS is 
uninstalled.

The old Panasonic-DMS is not uninstalled if the old version of the 
Panasonic-DMS has been installed before installing the new one.

Uninstall the old Panasonic-DMS from the Add / Remove 
Programs of the Control Panel. (Refer to “Removing the 
Panasonic-DMS Software” on page 31 and remove 
Panasonic-DMS instead of Panaboard UB-8 Software.)

31

The USB driver or printer driver 
does not work properly 
immediately after the installation 
of the software.

The Panaboard has not been registered in [Control Panel]–
[Scanners and Cameras] and [Printers].

Uninstall the software (refer to “Removing Drivers / Interactive 
Panaboard Software” on page 31) and install the software 
again (refer to “Installing Drivers / Interactive Panaboard 
Software” on page 28).

28
31

The computer does not recognize 
the electronic board.

Check that the electronic board is in the condition that enables 
operation or that the USB cable is connected properly. –

The electronic board is connected via a USB hub.
Do not connect via a USB hub. –

When the interactive function is used, communication port setting 
is not appropriate.

Change communication port setting according to “Setting the 
Communication Port” on page 35.

35

The Electronic Pen position may 
shift when the Projector mode is 
used.

The projection position shifts.
Calibrate to reposition the projected image on the screen. 33

Data written on the electronic 
board may disappear from the 
electronic board screen and the 
computer screen or its position 
may shift when the interactive 
function is used.

• Use the Electronic Pen inclined at an angle.
• Direct sunlight or strong light is striking the screen.
• A remote controller is being aimed at the receiver on the 

electronic board.
• The side of the electronic board is placed near the wall, or the top 

of the electronic board is placed near the ceiling.
• The electronic board is placed near the vents of an air 

conditioner.
• The receiver of the electronic board is blocked by a hand or other 

object.
• The transmitter of the Electronic Pen or the Electronic Eraser is 

covered with your hand.
• Two or more the Electronic Pens or the Electronic Eraser are 

used at the same time.
• If the position shifts for reasons other than the above, adjust the 

position according to “Adjusting the Shifted Position” on page 36.

–

Unnecessary streaks not written 
are displayed on the computer 
screen when the interactive 
function is used.

Do not do the followings near the electronic board while using the 
interactive function.
• Exchanging markers for interactive (small) of the Electronic Pen
• Setting or removing a marker cap of the Electronic Pen
• Pushing the point of the Electronic Pen

–
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The following table describes the meaning of each of the symbols which may flash in the Multi-Copy/Error Indicator.

If other indications appear, call your dealer.

Detection of the marker color of 
the Electronic Pen does not work 
well when the Whiteboard mode 
of the interactive function is used.

The marker for interactive (small) is not securely set.
Rotate the pen holder lever to the release position, and then 
return the pen holder lever to the lock position while inserting 
the marker until you hear a buzzing sound.

25

The proprietary marker for interactive (small) is not set into the pen 
holder.

Use the proprietary markers for interactive (small). 
82

The message "Low Battery" 
appears on the computer screen.

Replace batteries of the Electronic Pen or the Electronic Eraser 
which have “Low Battery” message displayed. 

25
77

Meanings of Error Codes

Indication Cause Remedy See
Page

(Error)

Data transfer error Connect the USB cable securely. 25

(Screen)

The screen will not move. Turn off the power and slowly move 
the screen by hand. –

(door)

The printer door is not closed 
securely. Close the printer door securely. 19

(Jam)

Paper jam Open the printer door and remove 
the jammed paper. 23

(ribbon)

The thermal transfer film is slack, has 
run out or is not installed.

Remove the slack from the thermal 
transfer film, replace or install the 
thermal transfer film.

18
22

(Paper)

Out of paper Load copy paper. 19

(Scanner Failure)

The scanner or screen is in strong 
sunlight or strong lighting.

Change the direction of the screen or 
block the light. –
0



Specifications

H
elp
Specifications
Model No. UB-8325

General Power supply Refer to the name plate on the printer
Power consumption
(Operational)

Refer to the name plate on the printer

External dimensions 
(Height × Width × Depth, 
without stand)

1,388 mm × 1,550 mm × 264 mm 
(4' 6 21/32" × 5' 1 1/32" × 10'  13/32" )

Mass (without stand) 34.0 kg (75 lbs.)
Ambient operating conditions Interactive Function

Temperature: 15–30°C (59–86°F)
Humidity: 30–80% RH

Other than Interactive Function
Temperature: 10–35°C (50–95°F)
Humidity: 30–80% RH

Ambient storage conditions Temperature: -20–60°C (-4–140°F)
Humidity: 15–80% RH

Writing implements Dry erase felt-tipped markers (black, red, blue and green *)
* The green marker is only for the interactive function.

PC interface Full Speed USB 2.0 *
*This electronic board does not function with Hi-Speed 
USB 2.0.

Input 
Block

Panel dimensions 
(Height × Width)

900 mm × 1,400 mm (2' 117/16" × 4' 71/8" )
[1664 mm (65 1/2") diagonal]

Panel surfaces 2 screens
Panel advance system Endless scroll type
Copying area (Height × Width) 850 mm × 1,330 mm (2' 915/32" × 4' 43/8" )
Scanning system Image sensors
Scanning resolution (Height × Width) A4: 1.6 x 1.7 dots/mm (40 x 43 dots/inch)

Letter: 1.7 x 1.6 dots/mm (43 x 40 dots/inch)

Output 
Block

Printing system Fusion thermal transfer type
Printing resolution 8 dots/mm (203 dots/inch)
Copy paper Standard or recycled paper [60 – 90 g/m2 (16 - 24 lb.)]
Copy paper size A4 / Letter*1

Copy color Black
Contrast adjustment Two levels: Normal/Dark
2-screen compressed copying Yes
Time required for copying 15 s/sheet
Continuous copies 1 to 9 sheets
Paper empty indication Yes
81
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*1Letter size is for U.S.A. and Canada models.
• The markers (big) and the eraser are used for other than the interactive function.
• The markers for interactive (small) are used while inserted in the pen holder.

The Electronic Pen [a marker for interactive (small) inserted in the pen holder] and the Electronic Eraser are used 
with the interactive function.

Interactive 
Function

Effective Area
(Height x Width)

Projector mode: 850 x 1,330 mm (2' 915/32" × 4' 43/8" )
* The position cannot be detected within 50 mm (2”) of the 

upper screen border.

Whiteboard mode: 825 x 1,330 mm (2' 815/32" × 4' 43/8" )
* The whiteboard cannot not be written on within 50 mm 

(2" ) of the upper screen border and 25 mm (1" ) of the 
lower screen border.

* It is not always possible to normally detect the position 
within 100 mm (3 15/16" ) of the position receiver and
35 mm (1 3/8" ) from the both sides of the screen.

Battery for Electronic Pen or 
Electronic Eraser

LR03 (AAA size)  x 2

*Alkaline battery
Battery Longevity for Electronic Pen 
or Electronic Eraser

48 hours [Continuously at 25°C (77°F)]

* When using Panasonic “LR03 (AAA size)” alkaline batteries.

Optional and Separately Available Items

Option Stand: KX-BP065
Wall-mounting kit: KX-B063

Separately
Available 

Items

Replacement film: UG-6001 (Set of 2 rolls [50 m (164' )])
Markers (big): KX-B031 (set of 10 black markers), 

KX-B032 (set of 10 red markers), 
KX-B033 (set of 10 blue markers)

Erasers: KX-B042 (set of 6 erasers)
Marker (big) and eraser set: KX-B035 (contains one black, one red, and one blue markers and 

one eraser)
For Interactive Pen holder:

Electronic Eraser:
Marker (small) set:

Eraser cloth
(for Electronic Eraser):

KX-BP038
KX-BP048
KX-BP0385 (contains one black, one red, one 
blue and one green markers)

KX-BP0481 (set of 10 cloths)
2
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For Your Safety

To prevent severe injury and loss of life, read this 
section carefully before using the unit to ensure proper 
and safe operation of your unit.

The following graphic symbols are used in this 
Installation Manual.

Safety check must be done by qualified 
service personnel after installing this option.

Be sure to disconnect the power cord while 
installing the unit. Otherwise, it may cause 
electric shock or injury.

Be sure to use the specified parts for the 
installation. Otherwise, it may cause fire, 
electric shock or injury.

Notes in the operating instructions or notes 
of labels on the cabinet, chassis or parts 
should be observed.

Denotes a potential 
hazard that could 
result in serious 
injury or death.

Denotes hazards 
that could result in 
minor injury or 
damage to the unit.

This symbol is used to alert 
operators to a specific operating 
procedure that must not be 
performed.
These symbols are used to alert 
operators to a specific operating 
procedure that must be emphasized 
in order to operate the unit safely.

Notice

WARNING

CAUTION

WARNING
4

Do not install the unit except by a qualified 
service personnel.

After installing or moving the electronic 
board, lock the casters and set the fall-
prevention extension legs.

If the unit is hung on a wall, confirm the wall 
must be capable of supporting at least the 
following weight.

1,005 N [103 kgf (227 lbs.)]

Do not attach the electronic board to 
mortared walls. Accidental electric leakage 
from the wall-mounting fixture bolts to metal 
laths or wire laths can cause heat, smoke or 
a fire.

Confirm the bolts of the unit are certainly 
caught by the wall-mounting fixtures by 
pulling the unit after hanging the unit on the 
wall-mounting fixtures if the unit is mounted 
on a wall.

Be sure to put on a glove to avoid electric 
shock or injury.

CAUTION

Locking the casters
(Push this side)

Push to lock



Assembling the Electronic Board
Installation
■ Accessories for assembling

The package includes the parts for setting up the electronic board shown below. Make sure that all of these parts 
are included in the package before proceeding.

No. Part Name Illustration Q’ty Remarks

Power cord

1

Wall-mounting 
template

1 For wall-mounting
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■ Assembly

1 Assemble the optional stand or wall-mounting kit.
■ If you are using a stand, refer to page 92.
■ If you are using a wall-mounting kit, refer to page 96.

2 Remove the electronic board from the shipping box.
Remove the joints, then remove the electronic board from the shipping box.

• Do not touch the screen film surface, as this may damage it.
• The shipping box, cushioning material, and other packing material will be necessary if you ever need to 

repackage the electronic board, so do not throw them away.

Manuals, CD-ROM, 
Eraser cloth (for Electronic Eraser)

Markers for Interactive

Batteries (6 pcs)

Pen holder (2 pcs)

Electronic Eraser

Eraser

USB cable
Power cord

Markers

Joints

Joints

Electronic board

Thermal transfer film

[Contents of Accessory Box]

Shipping box

Shipping box

Caution
6



Assembling the Electronic Board

Installation
3 Install the electronic board.

Install the electronic board using the stand (option) 
or wall-mounting kit (option). 

■ Using the stand (option)
1) Hang the electronic board on the optional 

stand.

• The electronic board can be mounted 
200 mm (7 7/8”) higher than hang position A 
by hanging it with the wing bolts B.

2) Secure the stand fixture to the electronic 
board using the two wing-bolts [M5 x 12 mm 
(15/32”)] provided with the stand (option).

A

B

■ Using the wall-mounting kit (option)
1) Hang the electronic board on the optional 

wall-mounting fixtures.

2) Secure the wall-mounting fixture to the 
electronic board using the two wing-bolts 
[M5 x 12 mm (15/32”)] provided with the wall-
mounting kit (option).

• When mounting the electronic board, avoid banging 
it. Such impact may break the internal light or cause 
other damage.

• After mounting the electronic board, gradually apply 
weight to it to make sure that the wall is strong 
enough to support it.

Caution
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4 Connect the power cord.

1) Securely fit the supplied power cord into the 
AC inlet on the printer unit.

2) Fasten the power cord through the center 
cable holder, as well as the left or right cable 
holder depending on the location of the AC 
outlet (see below).

•Left Location
When fastening through the left cable holder, 
fasten the power cord through the cable 
holders as shown below:

•Right Location
When fastening through the right cable holder, 
fasten the power cord through the cable 
holders as shown below:
8

5 Wipe the screen film surface.

Soak a soft cloth with water, wring well, and 
wipe the screen film surface.

• Do not wipe the screen film surface with paint 
thinner, benzene, or cleaners that contain abrasives. 
Doing so may cause discoloration.

• Do not wipe the screen film surface with a dry cloth. 
Doing so may create static electricity.

6 Check operations.

Refer to “Electronic Board Operations Check” 
on page 89.

Caution



Electronic Board Operations Check
Installation
After assembling the electronic board, perform the procedures presented in the following table to make sure it 
functions properly.

Step
Points to Check

Symptom Solutions

1 Turn on the power switch. “ ” flashes after “ ” lights up. (Normal operation)
(If not) Check power cord. (See step 

4 on page 88.)

2 Open the printer door and attach the 
accessory thermal transfer film, then 
close the printer door.
• Installing Thermal Transfer Film 

procedure (refer to the Operating 
Instructions on page 18)

“ ” flashes. (Normal operation)
(If not) Check thermal transfer film.

3 Open the paper cover and insert 
ordinary A4 (Letter) test paper, then 
close the paper cover.
• Loading Copy Paper procedure 

(refer to the Operating 
Instructions on page 19)

“ ” lights up. (Normal operation)
(If not) Check copy paper.

4 Open the printer door. “ ” flashes. (Normal operation)
(If not) *1

5 Close the printer door. “ ” lights up. (Normal operation)
(If not) *1

6 Press . Screen is fed. (Normal operation)
The screen film surface is not fed 
smoothly. *1

There are strange noises.

7 Use the accessory marker to draw 

a large  filling the entire 

copyable area of the screen film 
surface.
•Copyable area (refer to the 

Operating Instructions on page 
11)

Press  twice.

Press .

“ ” lights up and three copies are 
made.

(Normal operation)

Three copies are not made. *1

The entire readable area is not 
printed.
There are strange noises or paper 
jams during the copying process.
Multiple sheets of paper are fed 
through at the same time.

8 Press  to move the screen 
film surface. Write letters, etc. with 
the marker.
Press  once.

Press .

The Contrast/Remaining Film 
indicator light is turned on and one 
copy is made.

(Normal operation)

The Contrast/Remaining Film 
indicator light is not turned on. *1

The image is not copied properly.
There are strange markings on the 
copy sheet 
(e.g., stripes or lines).

9 Press  once. The Contrast/Remaining Film 
indicator light is turned off.

(Normal operation)

(If not) *1
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Electronic Board Operations Check

9

*1 Contact the store or dealer from which the unit was purchased.

■ Interactive Operations Check

1 Install the software on the computer and connect the supplied USB cable according 
to “Installing Drivers / Interactive Panaboard Software” on page 28.

2 Check that the interactive function operates.

• If the Electronic Pen position shifts, adjust the position according to the instructions on page 36.

10 Press . Two screens are copied 
properly.

(Normal operation)

(If not) *1

Step
Points to Check

Symptom Solutions
0



Repacking
Installation
Perform Assembly Steps 2 through 4 on pages 86 - 88 in reverse to repack the electronic board and accessories. 
Use the joints to fasten the shipping box.

• Do not touch the screen film surface, as this may damage it.

Manuals, CD-ROM, 
Eraser cloth (for Electronic Eraser)

Markers for Interactive

Batteries (6 pcs)

Pen holder (2 pcs)

Electronic Eraser

Eraser

USB cable
Power cord

Markers

Joints

Joints

Electronic board

Thermal transfer film

[Contents of Accessory Box]

Shipping box

Shipping box

Caution
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9

Assembling the Optional Stand (KX-BP065)

■ Accessories

The package box for the optional stand includes the parts noted below; please confirm that all parts are present 
before beginning installation

.

*1 The accessory wrench is required to fasten or loosen the screws , ; please store it carefully for future use.
*2 These are used for other models.

●Before assembly, be sure to lock the casters.

No. Part name Illustration Q’ty No. Part name Illustration Q’ty

Stand base 2 Wing bolt
M5 x 12 mm (15/32”)

6

Pipe 2 Support 
bracket 2

Cover 2
Fall-preven-

tion extension 
leg

4

Side bar (A) 2 Screw
M6 x 60 mm (2 3/8”)

4

Side bar (B) 1 Nut 4

Screw
M8 x 45 mm (1 25/32”)

12 Wrench
             *1

1

Fixture
(left) 2

Wing bolt
(Not use*2) M4 x 8 mm (5/16”)

8

Fixture
(right) 2

Screen holder 
bracket

(Not use*2)
4

Locking the casters
(Push this side)

Releasing the lock
2



Assembling the Optional Stand (KX-BP065)

Installation
■ Assembly

1 Assembling the stand
■ Assembling the fall-prevention extension legs
The fall-prevention extension legs increase the safety of the electronic board.

• Install and always set the fall-prevention legs when using the stand.
• When tightening the screw , hold the nut  with pliers.

Note
• When folding back the fall-prevention extension legs, release the lock as follows.

■ Inserting the covers  to the pipes 

Fall-prevention extension legs
• Caster locks are attached to 

the back side.

Caution

1

1
2
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Assembling the Optional Stand (KX-BP065)

9

■ Assembling the stand

Note
*1 Do not tighten the screw  too much. This may deform the pipes.

Assemble with the holes 
toward the front.

           

Locking
casters side
(rear)

Pull the fall-prevention extension legs 
down (fall-prevention extension legs 
will be fixed by the lock pin.)

1

1

1

2

Locking casters side
(rear)
4



Assembling the Optional Stand (KX-BP065)

Installation
2 Attach the fixtures   with the four wing-bolts.

3 Assemble and install the electronic board.
Refer to step 3 on page 87.
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9

Optional Wall-mounting Kit (KX-B063)

Before attempting installation of this wall-mounting kit, we strongly recommend consulting with the building manager, 
engineer, or architect. The installer needs to know the type of construction used for the wall intended for this 
installation and the location of wall studs. Selection of hardware is critical for safe wall-mounting, and depends on 
the nature of wall construction. Installation should not occur until this consultation takes place.

• Do not attach the electronic board to mortared walls. Accidental electric leakage from the wall-mounting 
fixture bolts to metal laths or wire laths can cause heat, smoke or a fire.

1. Tools required:
A minimum of eight (8) pieces of appropriate wall-support hardware (molley, toggle, etc.)
NOTE: THIS HARDWARE MUST BE LOCALLY PROCURED, IT IS NOT INCLUDED IN THE KIT.
Drill (and drill bit of correct size) for hardware installation
Screw driver (Both phillips (+) and slotted (–) will be required.)
Tape measure
Tape or thumb-tacks (2 pcs)
Bubble type level

2. Pre-requisites
1. Before installation, make sure that the wall intended for installation is capable of supporting flush-

mounted.
UB-8325 is 103 kgf (227 lbs.).

2. The position of the intended installation is of adequate size for the selected Panaboard.
UB-8325 is 1,516 mm (H) × 1,550 mm (W) [5' (H) × 5' 2" (W)].

3. An outlet is within 3 m (9' 101/8" ), and not located behind the Panaboard.

■ Accessories
The package box for the optional wall-mounting kit includes the parts noted below; please confirm that all parts are 
present before beginning installation. Eight screws for mounting the fixtures on the wall are not provided. Please 
purchase the appropriate wall-mounting hardware (sold in stores). Refer to page 98.

*These are used for other models.

No. Part name Illustration Q’ty No. Part name Illustration Q’ty

Wall-mounting 
fixture L 2 Screw

(Not use*)
M4 x 16 mm (20/32”)

4

Wall-mounting 
fixture R 2

Wall-mounting 
template

(Not use*)
1

Wing bolt M5 x 12 mm (15/32”)
(For mounting of the 

electronic board)

2

Use the wall-
mounting template 
provided with 
UB-8325.

Caution
6



Optional Wall-mounting Kit (KX-B063)

Installation
■ Wall-mounting procedure

1 Confirm that the wall is strong enough to support the weight of the electronic board.

The wall must be capable of supporting at least 
1,005 N [103 kgf (227 lbs.)] for UB-8325.

2 Tape the Wall-mounting template on the wall.

•Do not use the template included in the wall-mounting kit (KX-B063), but rather the one included with the 
electronic board (UB-8325).

•When taping the template on the wall, make sure it is level.

3 1) Drill holes in the wall for the wall-mounting fixtures (8 holes total).
•Holes on the wall-mounting fixture are 7 mm (1/4") in diameter.

2) After removing the wall-mounting template, attach the wall-mounting fixtures 
with the appropriate wall-mounting hardware (two screws in each fixture).

* This hardware must be locally procured, it is not included in the kit.

•Refer to the section “Attaching the wall-mounting fixtures” (page 98) for drilling in the wall and attaching the 
mounting fixtures.

•Refer to step 3 on page 87 for mounting the electronic board.

Caution

Wall-mounting
fixture L

Wall-mounting template
(provided with UB-8325)

Wall-mounting 
hardware*

Wall-mounting 
hardware*

Wall-mounting
fixture R              

812.8 mm (2' 8")

76
2

m
m

(2
'6

")
50

 m
m

(1
 3

1 /
32

")

70
 m

m
(2

 3 /4"
)  

2

1

Wall-mounting
fixture L

1

406.4 mm (16")
Center of the 
electronic board

(See page 85.)
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Optional Wall-mounting Kit (KX-B063)

9

■ Attaching the wall-mounting fixtures

The electronic board must be mounted with the method most suited to the material of the wall.
Three methods are presented here.
(Other options may be available in your area.)

●Attaching to metal or concrete walls
Stud plugs (sold in stores) are needed.

Drill eight holes in the wall.
For the correct hole size, refer 
to the instructions for the 
particular stud plugs used.

Insert each bolt through a hole 
in the wall-mounting fixture and 
tighten until the wall-mounting 
fixture is securely fixed to the 
wall.

Drill bit

Metal or concrete
wall
Stud plug

Insert a stud plug in each hole.

Wall-mounting
fixture

Bolt
8



Optional Wall-mounting Kit (KX-B063)

Installation
●Attaching to plasterboard walls
Split-wing toggles (sold in stores) are needed.

●Attaching to wooden walls
Use wood screws (sold in stores).

Insert each bolt through a hole 
in the wall-mounting fixture and 
into the hole in the wall beneath 
so that the arms of the split-
wing toggle are horizontal. For 
the correct hole size, refer to the 
instructions for the particular 
split-wing toggles used.

After the arms expand, pull the 
wall-mounting fixture out until 
the arms of the split-wing toggle 
grip firmly into the wall.

Tighten each bolt until the wall-
mounting fixture is securely 
fixed to the wall.

Plasterboard

Split-wing toggle
Wall-mounting
fixture

Bolt

Arms

Arms

For the correct hole size, refer 
to the instructions for the 
particular wood screws used.

Wall-mounting fixture

Wood screw

Wooden wall
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Information on Disposal for Users of Waste Electrical & Electronic Equipment (private households)

This symbol on the products and/or accompanying documents means that used electrical and electronic 
products should not be mixed with general household waste.
For proper treatment, recovery and recycling, please take these products to designated collection points, where 
they will be accepted on a free of charge basis. Alternatively, in some countries you may be able to return your 
products to your local retailer upon the purchase of an equivalent new product.
Disposing of this product correctly will help to save valuable resources and prevent any potential negative 
effects on human health and the environment which could otherwise arise from inappropriate waste handling. 

Please contact your local authority for further details of your nearest designated collection point.
Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

For business users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

Information on Disposal in other Countries outside the European Union

This symbol is only valid in the European Union.
If you wish to discard this product, please contact your local authorities or dealer and ask for the correct method of disposal.
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